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From the Author

As this book was written, in late 2006, I was still exploring a beta version of Excel
12, which is part of Office 2007. I realized that I had to make a crucial decision:
whether or not the book's figures and instructions should take account of Excel 12's
radically different user interface.After I regained my composure and got back on my
chair, I saw that my decision required a sober explanation, and here it is.

Excel 12 — along with the other Office 2007 applications — has dispensed with
the menu structure that's been around since Excel was MultiPlan. The thinking at
Microsoft was that there just had to be a more intuitive way of grouping tasks than
the old menu structure. People were confused by looking for tasks that had to do with
files in a File menu; tasks that had to do with editing in an Edit menu; and so on.

So Microsoft came up with the Ribbon, a toolbar that stretches across the top of
the worksheet. The Ribbon has several tabs, similar to the tabs often found at the top
of a dialog box. In Excel's case, the standard tabs are Sheet, Insert, Page Layout,
Formulas, Data, Review and View. These tabs organize tasks in a much more intu-
itive fashion than the old menus. For example:

To select a font, you use the Sheet tab. Or you use the Page Layout tab. It
depends. If you want to name a cell or range, you use the Formulas tab. If you want
to set Excel options such as whether to recalculate automatically or manually, you
don't use a tab — you use something called the File button.

We wanted to get this book published before the end of the current presidential
administration, so I decided not to cover the interface changes introduced in Excel
12. I'm depending on the fact that most people who might read this book have
clients who use an earlier version of Excel. (Many corporations still use Office 97,
because it's a major undertaking to move to a more recent version in a networked
environment, and the benefits of an upgrade don't clearly justify the costs.)

But if you or your clients have acquired Excel 12, you'll still find this book use-
ful for accounting matters. The tools, formulas and functions discussed here work in
Excel 12 as they always have. You might have a more difficult time finding them in
Excel 12, but I'm told they're all still there somewhere.

Conrad Carlberg
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Download the Example Files

You can download the Excel workbooks that contain the original data for all the
examples and worksheet figures that appear in this book. The files are available for
downloading at www.cpa911publishing.com. Click the Navigation Button labeled

Downloads.

The files are compatible with all versions of Excel from Office 97 through
Office 2003. Excel 12 (in Office 2007) will also open the files but will want to save
them in a new format, with a different extension; usually .xlsx or .xlsm.


www.cpa911publishing.com
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Chapter 1
Using Lists in Excel

Defining a List
Sorting Lists
Filtering lists
Managing a List

Using the Data Form

get its total, or turn it into a report, or for any of a dozen different reasons.

But you don't do it for fun. So if you're serious about it, you should know
how to organize the data: how to lay it out, how to label it, when to keep it separate
from other information, how to edit it, and so on.

You put data into an Excel worksheet so that you can chart it, or analyze it, or

Defining a List

Wearing my Excel consultant hat, I've seen some pretty strange ways of laying out
data on a worksheet. Granted, the people who designed those worksheets had what
they thought were pretty good reasons for their layouts. Sticking totaling rows into
the middle of what is in effect a database probably seemed like a good idea at the
time.
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Still, we all encounter worksheets with strange arrangements of data. One that
you've probably run across occurs when someone pastes an existing report from an
accounting package into a worksheet. A layout that works well for a report can be
spectacularly useless as the basis for an analysis or a chart. See Figure 1-1 for an
example.

A | B | o | 0 | E s
Northwest Region
Warch 2003

ES

| 2 |

| 3 | Taowels $ 5822164
4 Arearugs | $ 57 A4
| & | Slipcovers  $ 53,330.85
B Placemats | $ 48,000.61
7

8 |Subtatal, March 2003 $217.094.21
&

0 April 2003

ans Towels $ 544491.18 ||

52 Arearugs | % 80,829.70

iz Slipcovers | $ 57,531.81

14 Placernats | $ 36,324.01

il Tahlecloths | $ 52 676.73
16

17 |Subtotal, March 2003 $251,85343
g

19 hay 2003

20 Towels | $ 55,183 57
21 Arearugs | $ 36,340.23
22 Slipcovers | $ 17,169.76

124 |Subtotal, Mary 2003 | EXTEREEGEL

W 4 » »[\Regional Report ; |« | | v

Figure 1-1 Excel doesn't know where to find the values that it should
use.

Suppose you wanted Excel to show you the total of the figures in Column C for
Towels plus those for Tablecloths in the Northwest region. You'd have to create a
formula like this one:

=C3+C11+C20+C15

You find yourself pointing-and-clicking at cells and ranges instead of using
something quick and simple like this:

=SUM(C2:C8)
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But you can use a simple formula like that one if you've set up your figures properly
— and in Excel, that usually means in the form of a /isz. Figure 1-2 shows what an

Excel list looks like.

A B i D | E | F | G R
1 |Date Sold Region Product Sales =
|2 March-03 Mortheast Arearugs 3 4782449
8 June-03 Mortheast Arearugs 3 1277793
4 April-05 Mortheast Arearugs 3 21,798.71
| & May-05 Mortheast Arearugs | 3 30404 28
| & | July-06 Mortheast Arearugs | 3 11,82577
7 | February-03 MNortheast Placemats | $ 4769637 B
8 July-04 Mortheast | Placemats | $ 0 19,373.49
9 | Septernber-08 Mortheast Placemats | $ 48,967.02
10 March-04 Mortheast  Slipcovers | $ 14,758.90
ikt June-04 Mortheast  Slipcovers | $ 10,746.93
12 August-04 Northeast  Slipcovers | $ 36,402 .82
13 | Septemnber-04 MNortheast  Slipcovers | $ 3743896
14| Januan-08 Northeast Slipcovers | $ 642915
15 June-05 Mortheast Tablecloths | $ 47,807.36
16|  October-03 Northeast | Towels $ 46,2874
17 | November-03 Northeast | Towels $ 2185543
18 February-05 Mortheast | Towels $ 284417 o

W 4 » ¥y Regional Product Sales /| 4 |

Figure 1-2: This layout makes

as totaling.

| i

it much easier to do something as simple

The data you see in Figure 1-2 is arranged so that it's easy to total. For exam-

D:

=SUM(

ple, to get the total of the sales dollars, just type this in a blank cell outside column

Then, click the D at the top of column D, and press enter. Your formula will

now look like this:

=SUM(D:D)

NOTE: Don’t enter the formula itself in Column D because
you'll get a circular reference error: the result of the formula
would depend on the formula itself.
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NOTE: SUM(D:D) is a quick-and-dirty formula. If you have an
extraneous numeric value somewhere else in column D, it will
be part of the total that's calculated by the SUM function. It's
usually better to specify the cells, not just the column: for
example: SUM(D2:D55) to get the total of the values in cells
D2 through D55.

It happens that the arrangement of data shown in Figure 1-2 conforms to the
requirements of an Excel list:

» Each row represents a different transaction. (In this case, anyway.
You could also use the list to keep track of your kangaroos; in that
case, each row would represent a different kangaroo.)

* Each column represents a different variable (or field, which is just
another term for the information you're putting in the column).

* Each column is headed by the name of the variable.

That's it. If your data conforms to the requirements bulleted above, you have a
list. And Excel agrees with you.

What does a list buy you? Quite a bit, in fact:

* Some things that you'd like to use Excel for just can't be done with-
out data structured as a list; this chapter discusses a couple of exam-
ples and you'll find more in later chapters.

* Other things can be done without a list, but only with more effort,
sometimes a lot more effort. The SUM situation discussed in the
prior section is a good example.

Still, a list is not really a formal structure in Excel. An Excel workbook has all
kinds of formal structures — things that you use and manipulate — such as work-
sheets, charts, menus, cells, rows and so on. These structures are built into what's
called the Excel object model.

NOTE: | won't have much to say about the Excel object model
in this book. It's only a little less complicated than a detailed
outline of FASB regulations.
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And you won't find an object like a list in that object model. It's informal, and
yet something with a list structure is needed if you want to:

* Create a pivot table or pivot chart

» Use the Data Form

» Use Excel's AutoFilter

* Use tools like Histogram and Moving Average

» Copy data from a worksheet and paste it into a true database (and
vice versa)

* Look up a value in a table (for example, a commission rate based on
product sold and revenue recognized)

...as well as do other Excel tasks.

So if you set up your data as described in this section, you'll make your life
with Excel a lot easier — starting with sorting the data.

Sorting Lists

Excel enables you to sort on up to three keys simultaneously. This means that you
might sort a company's costs first on cost center, then on vendor within cost center,
and then on invoice date within cost center and vendor. Each of these (in the exam-
ple, cost center, vendor and date) is what is usually termed a key.

Sorting on One Key

More frequently, though, you find yourself sorting on just one key. The next few fig-
ures show how this works.

The list in Figure 1-2 started out sorted by Region, then by Product, and then by
Date Sold. Suppose you wanted to change the sorting priority, and sort the informa-
tion solely by Date Sold. You can ignore Region and Product, and get your date-only
sort by taking these steps:

1. Select any cell in the Date Sold column. (This step isn't a necessary
one, but it can make things easier in Step 3.)

2. Choose Sort from the Data menu. The dialog box shown in Figure
1-3 appears.
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3. Start by selecting only one sort key. Because you started in Step 1
by choosing Date Sold, that's the field that Excel proposes as the
sort key.

4. Click OK.

A | B | C | o] | B | F G |ERE=
1 |Date Sold Region  Product  Sales - i
29 Warch-03 Northeast Areaugs  §  47,924.49 il El@
3| June-03 Mortheast Arearugs § 12,777.93 | | sortby
_4 ] April-05 Mortheast Arearugs & 21,798.71 [Dare 5od -] * Ascanding
it May-05 Nurlhieast  Ared rugs $ 3n4nd 28 ™ pesrending
_A | July-NR Noheast Arearmgs $ 1182577 | | thenby
7| Febrary-03 Morhesst Placemals $ 0 57 A5R 37 [ =] @ ascendng
_8 | July-N4 Northeast Placemats $ 19378449 " Destepding
_9 | September-05 Northeast Placemats § 4RART 02 | | Thenby
n | March-Nd Northeast  Shpcovers $ 14,7689 80 [ =]  Ascendina
1] June-04 Northeast Slipcovers & 1074693 " Descending
2] August-04 Northeast Slipcovers $ 3640282 | | My dstarangs has
13| September-04 Mortheast Slipcovers $ 3743096 & leaderrow (" Noheader row
14| January-05 Northeast Slipcovers  § 6.429.15
5 June-05 Northeast Tablecloths ¢ 47.007.06 | | options... | ok | concel |
16| October-03 Northeast  Towels $ 4620741
A7 | Novernber-02 Northeast  Towels $ 2105542
10| TFebruary-05 Northeast Towels 3 254417

fr

+ H ) Regional Product Sales 4| 4 | |

Figure 1-3: The Options button gives you additional sorting tools, such
as left-to-right instead of top-to-bottom.

Figure 1-4 shows the result.

A | B | c n e i G lH] —=
_1 |Date Sold IRegion Product Sales |
_2 | Februoary-03 Mortheast Placermats § 57,656.37
Eas| March-03 Murlheast Arearugs § 0 4792449
Sis| Apnil-03 Morlbneesl Areaugs 0 5754141
i May-N3 Suutheas! Areamgs 30 11A3533
_A | June-NA3 Norbieast Areags $0 1277783
15| July-N3 Morbeees) Placemals  $0 48000 /1
8 | August-N3 Nothwest Slipeovers 3 53,330 55
_8 | September-N3 Snutheast Placemats  § 40,304 51
A0 | Orctober-N3 Notheast  Towels $ 4RIATH
11| Movember-03 Northeast  Towels § 2180543
12| December-03 Southwest Towels § 3470595
13| January-04 Northwest Towels $ 5022164
14| [ebruary-04 Morthwest Tablecloths $ 52.576.72
A5 March-04 Mortheast Slipcovers  $ 14,799.90
6| April-04 Southeast Slipcovers  §  31.901.07
el May-04 Southeast Tablecloths § 416540
10 | June-04 Mortheast Slipcovers § 10.746.92

M 4 + »}Regional Product Sales 4| 4 |

|

"l

Figure 1-4: The list is now sorted in ascending Date Sold order. Within
any particular date, the records are in their original order.
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TIP: If you're sorting on one field only, you can get the same
result by selecting any cell in the Date Sold column and then
clicking the Sort Ascending button on the main toolbar

With the records sorted in ascending date order, earliest to most recent, you
can sensibly use a chart to show how revenues have moved over time. See Figure
1-5.

|| | O O S| = O 0 O O e | 0 |
1 |Date Seld Region Product Sales i
2 | February 03 Northeast  Placemats &7,6a6.37 Sales

3 March-03 Mortheast  Area rugs 4782449

4| April- 03 Morthwest Area rugs 5750141 £70,000

5| May-03 Southeast Area rugs 1163533 "

[ June 03 Mortheast  Area rugs 12,777 83

7 Juhy-03 Mortinwest Placermats 48000 /1 $60,000

a | Auust-03 Northwest Slipcovers 53 330 55

9 | September-03 Smtheast Placemats 40,304 51 \A A }\ |'|

10| October-03 Notheast Towels 4E,787 41 $50,000

11| MNovemnber-03 Morheast Towels
12 | December-03 Southwest Towels

21 85643 ¥ \/
34,755 95 F\ /\
5822164 | $40,000

B B R R R R R R I

13| January-04 Nomhwest Towels \

14| February-04 Northwest Tablecloths 52 B76.73

s March-04 Northeast  Slipcovers 14,784 40 i [\ i A

16 April-04 Southeast Slipcovers 31,00187 | $30.000 I

rdl May-04 Southeast Tablecloths 416540 v l‘ v \ V V \ U

18 | June-04 Northeast  Slipcovers 10,746.93 ot

1) July-04 Northeast Placemats 1937049 | $20.000 {

20| August-04 Mortheast Slipcovers JE402.02

21| Septernber-04 Northeast  Slipcovers 37,430 96 £10.000

22|  October-04 Mortrwest Area rugs 2232438 V I

23| MNovember-04 MNorthwest Placemats 44,967 32 u V
24 | December-04 Morthwest Slipcovers 4143359 3 — . N ——_
25| January-05 Northeast  Slipcovers 642915 g3 a8 g3 35388988 cE g~
% | February-05 Mortheast Towels 254417 R R E R R
27| Msarch-05 Nonthwest Tablecloths 32,636.00 =3 Z2d=32L=I28=232L
] Aoril-0% Mortheast  Area rugs 21,798.71 -

W &+ w)Regional Product Sales |« |

Figure 1-5: With your list sorted in date order, it's easy to create a chart
that shows the data as a time series.

Sorting on Multiple Keys

In practice, you don't often find a reason to sort on more than one key at a time. One
reason is that you seldom need to look at the order of records in secondary keys.
Another is that tools such as pivot tables do a better job of grouping records than
pure sorting does.

But Excel lets you sort on as many as three keys, so here's a look at how you
might sort first on Region, then on Product, then on Date Sold. Figure 1-6 shows the
unsorted records.

14
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| A | B | & | 0 | E | F | & H =
1 |Date Sold Region  Product Sales - e
] April-06 Northwest Slipcovers $ 200271.01 poll @@
30 April-03 Northwwest Arearugs $ 5754141
4| August-04 Mortheast Slipcovers $ 3640282 regio & fscending
_& | February-03 Mortheast Placemats $  57,656.37 " Descending
_B | Februany-04 Northwest Tablecloths $ 5267673 Then by
_7 | February-07 Northwest Tablecloths $  20,743.80 m & asgending |
8} March-06 Southwest Placemats $§  32,322.12 " Descending
9| March-03 Mortheast Arearugs $ 47.92449 Then by
10| July-06 Mortheast Arearugs  $ 1182577 IDate Sold ¥ | @ Ascending
11| February-05 Northeast Towels $ 254417 " Descending
2] July-04 Naortheast Flacemats $  19,378.44 | | Mydatarange has
3 March-07 Southwest Slipcovers §  28,512.82 % Header row " Wo header row
4] June-05 Northeast Tablecloths $  47.807 .38
_15| December-03 Southwest Towels $ 3475595 Options. .. I oK I Cancel |
6]  Qctober-05 Morthwest Tablecloths $ 4857110
17 July-03 Morthwwest Placemats $ 48,000 61
18] June-04 Northeast Slipcovers  § 10,746.93 =
4 4 » » % Regional Product Sales ¢ | « | | vl

Figure 1-6: Sorting this list is feasible, but in time these situations will
always make you think of a pivot table.

You start the three-sort-key process the same way that you do the one-key
process:

1. Select a cell in the column that you want to sort on first; in this
example, that's the Region column.

2. Choose Sort from the Data menu.

3. Accept Region as the field in the Sort By drop-down.

4. Click the second drop-down (refer back to Figure 1-3), the first of
the two that are labeled Then By. Choose Product from the drop-
down list.

5. Click the third drop-down (again, refer back to Figure 1-3), and
choose Date Sold from the drop-down list.

6. Click OK.

NOTE: The Sort Ascending button on the main toolbar doesn't
handle multiple sort keys — just one, the selected column. If
you want to sort on more than one key, use the method
shown here.
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As you see in Figure 1-7, the full list has been sorted first by Region; then,
within each value of Region, by Product; and finally, within each combined value of
Region and Product, by Date Sold.

| A | B C | D E | F | & H =

1 |Date Sold Region Product Sales =
| 2 || March-03 Mortheast Arearugs  $ 4792449
5 June-03 Mortheast Arearugs $ 1277793
4 April-05INortheast  Area rugs $ 2179871
5| May-05 Mortheast Arearugs  $ 3040428
B July-06 Mortheast Arearugs  § 1182577

7 | February-03 Mortheast Placemats $ 57,656.37 b
8| July-04 Mortheast Placemats  $ 1937848
9 | Septernber-05 Mortheast Placemats  $ 48.867.02
10 March-04 Mortheast Slipcovers | $ 14,788.90
| June-04 MNortheast Slipcovers | § 10,746.93
12 August-04 Mortheast Slipcovers | $§ 36.402.82
13 | Septernber-04 Mortheast Slipcovers  $ 3743896
14| January-05 Mortheast  Slipcovers | 6429.15
15| June-05 Mortheast Tablecloths $ 47,807 .36
16|  October-03 Nartheast Tawels $ 4628741
17 | Novermnber-03 Mortheast Towels $ 2185543

18| February-05 Mortheast Towels $ 2544 .17 -

4« » »yRegional Product Sales ¢ | < | | vl

Figure 1-7: In Excel sorts, numbers come before letters.

In management accounting situations, sorting on more than one key usually
occurs when you want a report distributed in sections. In the example shown in this
section, a CFO might want to show sales by date, within product — just as it was
sorted in the last set of steps — but have a different report distributed to each
regional sales manager. The best way to handle that is to do the three-key sort just as
shown above, and then to split the report physically into regions with page breaks.

TIP: Insert a page break in a worksheet by selecting a row
where you want the break, then choosing Page Break from
the Insert menu. The page break appears above the row you

selected.

Unsorting a List

There's one particular popular report layout that makes me nuts. It uses a blank line
to separate one category from the next. Even though they may be helpful when it
comes to reading a report, | can't stand dealing with those blankety-blank blanks
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when it comes to analyzing or charting the data. They do nothing but get in the way.
Figure 1-8 has an example.

A7l 8 | ¢ | D | o | e | I=
1 [Year !Region Product Sales =
2
3 2003 Mortheast |Arearugs | $124,731.18
4 Placemats §126,001.88
e Slipcovers $105,817.76
5
7| 2004 Tahlecloths $ 47 807 .36
n:a Towels | $148,086.71
9
10} 2003 Morthwest Arearugs | § 7986580
11 Placemats § 142,385.89
g2 Slipcovers| $115,035.15
13 Tahlecloths $ 267,057 45
14 Towels | $101,230.92
s
16 2003 Southeast Arearugs § 46387.55
Bl Placemats ¢ 46,527 86
g
19 2004 Slipcovers $ 31,801.87
20 Tablecloth: $  4,165.40 o
21
22 2003 Southwest Arearugs  $ 1,028.55
s Placemats § 32,322.12 <

W 4 » M }yRegional Sales Report , | 4 | |

Figure 1-

8: The problem is to remove the blank rows and leave every-
thing else as is.

I use Excel to sort the blank rows out of the data, like this:

1. Type Row into cell E1. This isn't necessary but it helps keep things
clear.

In E2 enter 2. In E3 enter 3.

Select E2:E3. Put your mouse pointer over the Fill Handle in the
lower right corner of E3, hold down the mouse button, and drag
down into the final row (In Figure 1-8, that's row 23). You now have
a new field, named Row, in your list.

Sort the list, using Sales (or another field or fields) as the sort key.
The field to choose is one that has a value in all rows other than the
ones that are blank in all columns.
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5. You'll find that the blank rows have been sorted to the bottom. In
Excel sorts, blank values come after everything else.

6. Delete the blank rows at the bottom. You can do that in two
steps, just by dragging through their row headers and choosing
Edit = Delete. (But do this only if you feel compulsive about it;
the blank rows are now out of the way, so you can forget about
them.)

7. Re-sort the remaining records according to the values in the Row
column. This puts the list back in its original order.

NOTE: Excel uses the term AutoFill for the dragging operation
described in Step 3 of the instructions to sort blank rows out
of the data. As with nearly every operation in Excel, there are
several ways to do it, but this one is probably the cleanest if
you sort on more than one column.

Filtering Lists

When you filter a list in Excel, you're saying that there are some records that you
don't want to pay attention to for the time being. You want Excel to leave them out
of an analysis (for example, it ignores them when you use the SUM function), or
omit them from a chart, or not show them on the worksheet at all.

It's important to keep in mind that phrase in the prior paragraph, "for the time
being." In most cases you can filter some records to ignore them temporarily, and
then when you're ready you can bring them back into play.

There are a couple of different approaches to filtering in Excel; one is simple
and virtually automatic, and the other is a little more complicated and you have to
stay involved with what's going on.

AutoFiltering Excel Lists

In keeping with this chapter's main topic, you'll find that it's easier to filter records
that are in a list than records that are just hanging around the worksheet. Take a look
at Figure 1-9.

11
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Al B | c D | E | F | G | H | i
_1 | Name !Year Quarter Gross FWH FICA Net —
2 |Lenny 20086 Q1 $ 714017 $1,14680 |§ 53551 $ 545778
3 |Howell 2008 Q1 $13,73134 $3696.19 | $1,02985 $ 9,005.30
4 |Beu 2008 1 $ 530952 $ 56B.14 | § 24821 | $ 249317
5 |Daniell 2006 21 $ 742055 $2571268 $ 55722 ¢ 430107
_B [Cummins 2006 Q1 $ 075532  $313227 |$ 73165 § 589141
7 |Tafoya 2008 1 $1581280 $3,056.27 | $1,18596  $11,57057
B |Neil 20086 Q1 $265,26054 $3,92008  $2,121.04 $2223941
9 |Bell 2008 Q1 $2040924 $6,21050  $1,53069 $12,668.05
10 DeFratis 2006 Q1 $1256697 $265260 | § 94252 $ 897184
11 McCleary 20068 Q1 $1767222 | $ 96122 | $1,32542  $15,38558
12 |Marble 2008 Q1 $26,30350  $8,188.72 | $2,122.76 | $17,992.02
13 |Rouse 2008 1 $1582432 $1,013.14 | $1,18682 $13,624.36
14 |Garber 2008 N1 $ 555407 $115274 | § 26656 $ 213478
15 Rodgers 2006 Q1 $20,500.18 | $9,299.19 | $2,21251 | $17,98848 1=
16 \Kohout 2006 Q1 $1202235 $396106 $ 90168 $ 7,15961
17 |Sikorski 2006 Q1 $17,52995  $1,25350 | $1,314.75 | $14,961.70
18 |Blanch 2006 21 $1484762 $204146 | $1,11357 $11,69258
19 Lenny 2008 Q2 $16,15184  $238869 | $1,211.39 | $12,551.76
AU |Howell 2006 22 $11849.12 $166986 § B8BB68  F 9,29053
21 |Beu 2006 2 $2080968 $8,576.89 | $2,23573  $18,997.07
22 Daniell 2008 Q2 $ 474068 $ 23060 |§ 35555 $ 4,15452
ﬁiCummins 2006 02 $14,11324 $137285 $1,05849 $11,681.80

Figure 1-9: A year-to-date salary report for Castor Oil Corporation.

Because the report is set up as an Excel list, it's very easy to focus on just a
subset of records. Take these steps:
1. Select any cell in the list.
2. Choose Data—>Filter— AutoFilter.

3. Drop-down arrows appear at the head of each column, adjacent to
each list header.

4. Click the drop-down arrow for the field you want to use for filter-
ing, and choose the value that you want to keep. (Other options like
Top Ten are discussed later in this chapter.)

That's it. If you chose, for example, Q2 in the Quarter field, Excel displays only
those records in the list that have Q2 in Quarter's column.

TIP: When you head into a parking space, it's nice to know
how you're going to get out. To turn off the AutoFilter, choose
Data — Filter = AutoFilter — it's just a toggle.
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Figure 1-10 shows the list, filtered for Q1 using AutoFilter.

A | | B | D EA| i | ]

i Name v[ Year | Quarter | Gross | FWH | FICA .| Net
_2 |Lenmy 007 a1 $ 714017 £ 114690 § 53551 | § 5457 TR
3 |Howell 2007 @1 $ 1373134 ¢ 3E96.13 % 102985 ¢ 9,005.30
_x!_ji]eu 2007 @1 $§ 2330952 ¢ 56014 § 24021 § 249017
_& |Daniell 2007 @1 § 742955 ¢ 257126 $ 55722 § 430107
_EB |Cumming 2007 $ Yinoh32 ¢ 313221 ¢ f3Nks | ¢ 584141
7 |Tafoya 2007 @1 § 1581280 ¢ 305627 1,18506 ' § 1157057
B |Neil 2007 @1 § 28328054 ¢ 392003 § 212104 $ 2223341
_4 |Bell 2007 <yl $ 2040924 % 6,21050 % 1,53069 | % 12 668.05
10 |DeFratis 2007 @1 § 1256607 ¢ 265260 $ 34252 ¢ 807184
11 |McCleary 2007 @1 $ 1767222 ¢ 961.22 $ 132542 & 1538058
_‘I;_?MSFDIF_' 2007 $ 2830350 % 8,188.72 % 212276 |§ 1799202
13 |Rouse 2007 @1 § 158132 ¢ 101314 ¢ 1,18682 | § 1362436
14 |Garber 2007 @1 § 350407 ¢ 115274 % 26656 § 213478
__15__§Rnrigem 007 Q1 $§ 7350018 $ 979918 § 221251 | § 17 9AR 4R
16 |Kohout 2007 @1 § 1202235 § 396106 % 90168 § 7.,159.681
17 |Sikorski 2007 @1 $ 1752995 ¢ 125350 % 101475 §  14961.70
iEFIIannh 007 a1 $ 14847R7 % 04146 $ 1,11357 | $ 11, /492 58
3 |

Il

H 4 F H)Castm Salary 3umma|y,{|<|

Figure 1-10: Notice that some row numbers are missing.

-

Figure 1-10 suggests how AutoFilter does its work: the records that don't con-

form to the filter that you specify are hidden. Their rows are modified to have a
height of zero — this is the same as selecting a row or rows and then choosing

Format = Row — Hide.

NOTE: If you are already up on pivot tables, you might know
this, but just in case: You can't use AutoFilter (or the
Advanced Filter, for that matter) on a pivot table, even though
it might look like an Excel list.

Using AutoFilter Options

Figure 1-11 is Figure 1-9, repeated here for convenience. The AutoFilter has
already been selected and you see the options available from the Column D drop-

down.

Apart from the first three items in the drop-down list, there are only individual
values. As you saw earlier, you can select one of those values to filter out all records
that do not have that value in Column D.
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A = C | D | E F G o
1 Name v| Year v| Quarter v| Gross [¥] FWH +| FICA +| Net +| |
2 |Lenny 2006 Q1 hﬁopm M- $1.14690 § 53551 § 545776
3 |Howel 2006 Q1 Yetai 3 $3,696.19 $1,02985 $ 9,005.30
4 |Beu 2006 Q1 $3,309.52 $ 56814 |§ 24821 § 2483.17
5 |Daniell 2006 Q1 e $257126 | § 55722 $ 4301.07
6 |Cummins 2006 Q1 5,350.93 $3,13227 | § 73165 | $ 5839141
7 [Tafoya 2006 Q1 S $3,056.27 | $1,185.96 $11,57057
8 |Neil 2006 Q1 7,140.17 $3,92009 | $2,121.04 | $22,239.41
5 |Bell 2006 Q1 toaeas  — $6.21050 $153069 $12,668.05
10 |DeFratis 2006 Q1 §9,755.32 $2,65260 § 94252 § 897184
11 |McCleary 2006 Q1 s $ 86122 $132542 $1538648
12 |Marble 2006 Q1 11,549.12 $8,188.72 | $2,122.76 $17,992.02
13 |Rouse 2006 Q1 szoz ey $1,013.14 | $1,186.82 $13,624.36 e
14 |Garber 2006 Q1 $13,361.29 $1,15274 | § 26656 $ 2,134.78
15 |Rodgers 2006 Q1 $13,731.3_ T14929919 $2,212.51 $17,98848
16 |Kohout 2006 Q1 $12022.35 $3961.06 ¢ 901.88 $ 7,159.61
_17 | Sikorski 2006 Q1 $17529.85 $125350 $1314.75 $14,961.70
18 |Blanch 2006 Q1 $ 1484762 $204146 $1,11357 $11,692.50
19 |Lenny 2006 Q2 $ 16,151.84 | $2,38869 $1211.38 $12,551.76
20 |Howel 2006 Q2 $11849.12 $166986 ¢ B888.68 $ 9,290.58
21 |Beu 2006 Q2 $ 2980968 $8,57689 $223573 $18,997.07 =

WA % Castor Salary Summary /| « |

Figure 1-11: The All, Top Ten and Custom

The other three items work as follows:

items have special results.

* (All)... This option restores all the original records in the list: it un-

filters them.

* (Top Ten)... This option lets you select an ordered subset of the

records.

* (Custom)... This option enables you to specify more complex filter-

ing criteria than simply choosing a particular value in the list.

If you select the Top Ten option, you next see the dialog box shown in Figure

1-12.

You have the following options:

* The drop-down on the left, where Top is now selected, also lets you

choose Bottom.
* The box in the center, where 10 is now selected, lets you supply any
number between 1 and 500.
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* The drop-down on the right, where Items is now selected, also lets
you choose Percent.

ey

A = | D | E F G

1 Name v| Year »| Quarter v| Gross »| FWH «| FICA ~| Net |
2 |Lenny 2006 Q1 $ 714017 $1146890 $ 53551 § 545776
3 |Howell 2008 Q1 $13,731.34 $389619 $1,02985 ¢ 900530
4 |Beu 2006 Qi1 $ 330852 % 56814 § 24821 § 248317
5 |Daniell 2006 Q1 $ 742055 $257126 % 55727 ¢ 430107

6 [Cummins 2008 _d L7 ] 2
7 |Tafoya Eazie M Top 10 AutoFilter
8 |Meil 2008 Q1
9 |Bell 2006 Q1
10 |DeFratis 2006 Q1
11 [McCleary 2006 Q1 :
12 |Marble 2006 Q1 R |
13 |Rouse 2006 Q1 24 .38
14 |Garber 2008 Q1 $ 355407 $115274 § 26656 § 213478
15 |Rodgers 2006 @1 $ 2950018 $926919 $2212.51  $1798548
16 |Kohout 2008 Q1 $1202235 $3086106 $ 90168 § 7,153.81
7 | Sikorski 2006 Q1 $1752895 | $1,25350 $1,31475 $14 96170
18 |Blanch 2006 Q1 $ 1484762 $204146 $1,11357  $1183259
19 [Lenny 2006 Q2 $16,151.84 $238B6B9 $1.211.39 $12551.76
20 |[Howell 2006 @2 $1184912 $166986 ¢ B888BBE $ 920058
21 |Beu 2006 Q2 $ 2980962 $857689 $223573  $18997.07

4 4 » wf)Castor Salary Summary /| ¢ |

Figure 1-12: Use these options to define your Top Ten. They remain
selected until you change them, even across instances of

Excel.

What you get depends in part on what's in the list:

« If all the items in the column are text (for example, the letters A

through H and the word Management) then selecting Top Ten has

no effect.

If the items in the column are a mix of numeric and textual val-
ues, then only the numeric values will be shown by the Top Ten

option.

The number of items that the filter can display can be no greater

than the number of numeric values in the column. For example, if

the column contains 1, 2, 3 and D, choosing Top 10 and specify-
ing 5 values will display 1, 2 and 3 only.

15
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* If you choose to display Percent instead of Items, you will get the
top (or bottom) X Percent in the list, subject to the limits on text val-
ues and maximum counts I just mentioned.

Entr'acte: Deciding to Use AutoFilter

AutoFilter is a convenient way to look at a subset of your list, and it's quick to set
up. The drop-down makes it easy to focus on records that have a particular value in
a column. But as a practical matter, you're probably not going to have much use for
more advanced AutoFilter features, such as Custom filtering.

As you'll see in the next section, it's entirely feasible to use AutoFilter's Custom
criteria to focus on, say, office revenues for 2005 in the Northwest region. But set-
ting up AutoFilter to do that takes a little time, and when you subsequently want to
look at office revenues for 2005 in the Southwest region, you'll have to rebuild your
Custom filter. That extra time and effort tends to defeat the purpose of something
intended to be a handy tool.

It's much easier to use Advanced Filter or, better yet, a pivot table to do that
kind of analysis. Both are based on lists, just like AutoFilter, and they take about as
long to set up. But once you've done the setup, you have the results you want — to
continue the present example, you have office revenues for each year in each region
— and you don't need to rebuild anything when your interest shifts from one region
to another.

So: think of AutoFilter as a quick-and-dirty way of getting a look at a subset of
data: it's great for ad hoc peeks into a list. But even though Excel provides the tools
to make it more complex, resist the temptation. You'll save a lot of time and energy
in the long run, and you can save your best swear words for Microsoft itself, rather
than its innocent products.

Now that's off my chest, I can move on the AutoFilter's Custom filter with a
clear conscience, knowing that you'll skip it if you want to.

Using the Custom Criteria

With a list set up and the AutoFilter drop-downs visible, click one of the drop-downs and
choose Custom from the drop-down list. You see the dialog box shown in Figure 1-13.
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4 4 » w[yCastor Salary Summary /| 4 |

A = C | D | E | F | G | =
1 Name v| Year v| Quarter v| Gross »| FWH +| FICA +| Net +| =
2 |Lenny 20068 1 $ 714017  $114680 $ 53551 § 545776
3 |[Howell 2006 L A s o e A e I == R O L CLO0E S0
4 |Beu piilils Custom AutoFilter
iDanieII 200 Show rows where:
B |Cummins 2008 gross
_7_[Tafoya 200 |equals j || ﬂ
8 |Meil 200
5 |Bell : 200 &ad Cor
10 |DeFratis 200
11 \McCleary 200 | || =l
12 [Marble 200
H Rouse 200 Lse 7 ko represent any single character _—
W Garber 200 Use * to represent any seties of characters
15 |[Fodgers 200 Ok, | Cancel
16 |Kohout 2008 |
17 |Sikorski 2006 $17452895 | $1,25350 $1,31475 $14 96170
18 |[Blanch 2006 a1 $ 1484762 | $204146 $1,11357 $1163258
19 [Lenny 2006 22 $1615184 $238BR3 $121138 $1255176
20 [Howvell 2006 22 $1184912 $166986 ¢ 88868 $ 929058
21 |Beu 20068 22 $ 2980968 $B857689  $223573

$18,937.07 %
|

Figure 1-13: You can specify two operators (e.g., greater than and less
than) and two corresponding values for this field.

There are twelve operators you can choose from in the left hand drop-downs.
We won't enumerate them here (if you're interested, you can check by clicking one

of the drop-downs) beyond mentioning that they include:

* Equals
* Is less than
* [s greater than

You can do the same with another field in your list, and then the custom criteria
act as though they were connected by an and. Therefore, you could set up a custom
criterion for the Region field that calls for Region to equal "Northwest" and one for
the Product field that calls for Product to not equal "Towels." That would give you
sales in the Northwest for products other than towels.

And when you wanted to look at sales of towels in the Southeast, you do it over
again, changing the Region and Product custom criteria.

17
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Using Advanced Filters Instead of AutoFilter

There are some things you can do with Excel's Advanced Filters that you can't do
with AutoFilter. Here they are:

* Copy the filtered list to some other place on the worksheet.

* Show unique records only. This can be helpful if you want to find
out if you have duplicate records (the filtered list will normally be
shorter than the original) but it won't help you find the duplicates.

» Use complex criteria to filter the list. As you've already seen,
AutoFilter gives you selection criteria to work with, but the
Advanced Filter's criteria can be more sophisticated.

Getting More from Advanced Filter

One of the strongest points of the Advanced Filter is the ability to filter unique
records only. Suppose that these are the names of regions as they exist in your list:

¢ Northwest
¢ Northeast
¢ Southwest
¢ Southeast
¢ Southeast

Notice that there are two instances of Southeast. Although you can't see it here,
one of them is followed by a blank space. Apparently, someone mistyped the name
of the region, or some really esoteric glitch took place inside the black box.

TIP: This is a great reason to use Data Validation, which
allows you to create drop-downs in cells. The drop-downs limit
the possible entries to those that you want to allow. Choosing
Data — Validation walks you through the process.

You wouldn't know that this had happened — that is, an extra version of
Southeast sneaking into your list — without either poking around for one, or using a
tool such as Advanced Filter (or pivot tables) that highlight the presence of an erro-
neous value. Using Advanced Filter, you arrange for a shorter list consisting of the
original list's unique values.
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Here's how to filter for unique values in your list:

1. Select a cell in the list.

2. Choose Filter from the Data menu.

3. Choose Advanced Filter from the Filter menu.

4. In the Advanced Filter dialog box (see Figure 1-14) verify the List
Range address.

5. Click the Copy to Another Location option button. The Copy to box
becomes enabled.

6. Click in the Copy to box, and then click in the cell where you want
the filtered list to begin.

6. Fill the Unique Records Only checkbox.

7. Click OK. You'll get the result shown in Figure 1-15.

g = | ¢ | o | e | F | & | W | @ | 3
_1 |Region I
_2 Mortheast
_3 (Mortheast . o
_4 |Southwest Advanced Filter 3
_& |Mortheast :

_E {Mortheast 'qc;m_ -
LNDr’cheast 2 Eﬂter tthe Ilst;':n—pllacet
il\]ur‘theast opy [0 another [ocation
_9 IMorthwest List range:
10 yMorthwest
E e Criteria range: | E
12 |Mortheast | i
A3 Northeast I Unique records only
_14 INorthwest
_16 |Southwest ok | cancel | g
16 |Mortheast
17 |Southwest
18 }|Southeast
19 |Southeast
20 |Southeast
_21 tSouthwest -
4 4 » )y Problem List /| | | Wl

Figure 1-14: The list's range is filled in automatically if you start by

selecting a cell inside the list.

19
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A B | ¢ | o | E | F | & | H | v | =
_1 |Region | Region |
_2 |Northeast Mortheast

3 |Northeast Southwest

4 |Southwest Morthwest
5 |
B |
7

Mortheast Southeast
Mortheast Southeast
MNortheast
8 |Northeast
9 |Northwest
10 [Northwest
11 [Southeast
12 |[Northeast
13 |[Northeast
14 [Northwest
5 | Southwe st i
16 [Mortheast
17 |Southwest
18 |Southeast
19 |Southeast
20 |Southeast
21 |Southwest -
4 4 b by Problem List /|4 | ai

Figure 1-15: Notice that the Advanced Filter copies not only the records
but also the column header to the new location.

WARNING: If you use the Advanced Filter to copy filtered
records to another location, be sure there's no data already in
the columns you want to use. If you're copying the result into
columns C and D and there's anything anywhere in those
columns, it will be lost — and you can't Undo the results of
the operation.

NOTE: Your new location — the location to which you want
Excel to copy the filtered data — must be on the same work-
sheet as the original list.

As Figure 1-15 showed, there is at least one record in your list that's supposed
to be grouped with other Southeast region records, but it isn't; the trailing blank tells
Excel that it's a different region.
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Now that you know that there is such a record (or records), you can take a
couple of simple steps to find it. Probably the quickest is to start by sorting your
list on Region — the record with the trailing blank after "Southeast" will sort to
the bottom of other Southeast records.

However, you don’t yet know how many such records there are. So, after
sorting on Region, you might want to take these steps:

1. Select a cell that's outside the list, but in the same row as the first
Southeast record — which we'll assume is in cell A40.

2. Enter this formula: =LEN(A40) which returns the number of
characters in the value found in A40. (LEN stands for length.) In
this case, it should return 9, the number of characters in
Southeast.

3. Autofill the LEN formula down until you reach the row with the
final Southeast value.

4. Edit any versions of the Southeast value where the LEN function
does not return 9. In particular, a value with a trailing blank
would return 10: nine for the visible characters plus one for the
trailing blank.

How Excel decides that records are unique is partly a function of how many
columns are in the list that you filter. Using the data in the present example:

* If your list consists only of Region, there will be four unique
records — one for each region. Of course, if you had another
region, say Central, you'd get five unique records.

* If your list consists of Region and Year, you'll have up to twenty
unique records: four regions times five years. If there's no record
for a given year in a given region, that maximum of twenty will
drop to an actual of nineteen.

* If your list consists of Region, Year and Product, you'll have a
maximum of 4 X 5 X 5 =100 unique records.

* Finally, if your list consists of Region and Revenue, it's likely that
your list of unique records will be identical to your original list —
except in the unlikely situation where two or more regions have
exactly the same revenue.
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Complex Criteria

Even if you're not interested in unique records in your list, you can still make use of the
Copy To Another Location option. But in that case you'll want to specify some criteria
for the filter — otherwise, your filter will trivially return all the records in your list.

There are two general steps for setting up criteria for Advanced Filter:

* Choose a range of cells at least one column away from your list. In
the first row of that range, put the names of fields in your list that
you want to filter on. This is the first row of your criteria range.

* Below the name of each field in the criteria range, enter the values
that you want to keep: that is, the values that you want to filter for.

Figure 1-16 shows an example.

| A B ¥ | ] | €& DINEEEE H | | | L M T
1 |Year Region Product Sales Region Year Year Region Product Sales =il
2 | 20U3 Mortheast Arcarugs | 474924944 Morthwest 2UUS| 2005 Northwest |ablecloths | $32646.38
3 | 2003 Mortheast Arearugs | $1277793 2005 Morthwiest Tablecloths $43,008.21

4 2005 Mortheast Arearugs | $21.790 71 2005 Morthwest Tahlecinths | $49571 10
| 2005 Mortheast Arearugs | $30404.28
| 2006 Mortheast Arearugs | $11,825.77
| 2003 Mortheast Placemats | $57 656.37
8 | 2004 Murtheasl Placemals | $19,37849
| A Northeast  lacemats | 4104957 12 b
2004 Mortheast Slipcovers | $14,792.90
112004 Mortheast Slipcovers | $10,74693
2| 2004 Mortheast  Slipcovers $36.40232
| 2004 Murthewsl Slipeovers | $37 43898
| 25 Northeast  Slpeovers | 6 B 49415
2005 Mortheast Tablecloths  $417 807 36
B | 2003 Mortheast Towels $46,287 41
2003 Mortheast  Towels $21,.85543
:EEIDE Murtheast  Toanels $ 254417
| 2UUB Mortheast | owels $20,661 652
20| 2006 Mortheast  Towels $53,738.08
21| 7003 Northwest Arearugs | 357 54141 -
W 4 » M KHiter with Uritenia |4 | | Wl

Figure 1-16: You can avoid typing errors in the criteria range by copying
and pasting from the original list.

In Figure 1-16, the criteria range is F1:G2. The names of the fields in the list
that Excel should use as criteria for filtering are in F1:G1. The values of those two
fields that Excel should filter for are in F2:G2. These two criteria fields are treated
as if they were connected by an AND; Return any records where the Region is
Northwest and the Year is 2005. The filtered list has been copied to another location,
starting in cell 11.



You'll have less use for an implied OR connector in a criteria range, but
here's how to make one. Suppose, strangely, that you want to return any records
that are either from the Northwest region or from year 2005. Put those two crite-
ria in the same columns as before, but in different rows. Figure 1-17 shows how
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to do this.
&N B ¥ | ] [ _G |
1 I‘fenr_lRegion Product  Sales Region Year
2 | 2003 Mortheast Arcarugs | $4/92444 Morthwest
3 | 2003 Mortheast Arearugs | $1277793 2005
_4 | 7005 Northeast Arearugs | $21,790 71
_b | 2005 Mortheast Avearugs | $30404.28
6 | 2006 Mortheast Arearugs | $1182577
_ | 2003 Mortheast  Placerats | $57 656.37
8 | 2004 Muitheast Placernals | $19,37849
9 | 205 Mortheast lacemats | $41L457 07
10| 2004 Mortheast  Slipcovers | $14,799.90
112004 Mortheast Slipcovers | $10,746.93
12| 2004 Mortheast  Slipcovers | $36,402 82
13 | 2004 Murtheast Slpcovers | $37 43896
__1_d_: s Mortheast  Shprovers $ BE42M15
15 | 2005 Northeast Tablecloths | $417,807 .36
16| 2003 Mortheast Towels $46,287 41
14| 2003 Mortheast  Towels $21,.85543
IBf 2005 Murtheast  Tnanels $ 254417
19| 2UUG Northeast | owels $20,661 652
ﬂi 2006 Mortheast Towels $53,738.05
21| 2003 MNorthwest Arearugs | 357 54141

[ J
Year Region
2005 Mortheast
2005 Northeast
2005 Mortheast
2005 Northeast
2005 Mortheast
2005 Morthezast
2003 Murlbwvest
A4 Morthweest
2003 Morthwest
2004 Morthwest
2006 Morthwest
20068 Murlbwest
UL Maortfweest
2004 MNorthwest
2006 Morthwest
2004 Morthwest
2005 Murlbwwest
2005 Northwest
2005 Morthwest
N0A Morthwest

Figure 1-17: The filtered list is copied to another location,
ing rows as AutoFilter does.

You can even mix-and-match ANDs and ORs. With Southwest in F2, 2005 in
G2, and Southeast in F3, you'll get records from the Southwest in 2005 (the AND),
as well as records from Southeast regardless of their Year (the OR) — that is,

(Southwest AND 2005) OR Southeast.

Figure 1-17 showed the filtered list copied to a new location. If, instead, you
choose to filter the list in place, Excel hides the rows that don't conform to your cri-
teria, just as with AutoFilter. The easiest way to get those rows back is to choose

Data = Filter & Show All.

Managing a List

There's a way of managing lists that first showed up in Excel 2003. It offers little
you can't do in earlier versions, but it does bring some existing capabilities together

in one place. If you're new to lists, that can be handy.

K

L

Product
Arcarugs
Area rugs
Maremats
Slipcovers
Tablecloths
Towels
Ared ruygs
Area rugs
Placemats
Placemats
Placcmats
Placerrials
Shipeovers
Slipcovers
Slipcovers
Tahblccloths
Tablecluths
| ableclaths
Tahlecloths
Tahleclnths

Sales
£21,198.1
$30,404.28
F40967 N2
§ 642915
£47,807.36
£ 254417
$57.541.41
FU2 2
$48,000.61
F44,967.32
£20,338.22
$20,079.74
F L0 55
£4114133.69
$20271.01
$52676.73
£32,636.38
£40.000.41
£48,571.10
F12467 A1
|

to avoid hid-
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Suppose you have your data laid out as in Figure 1-17, shown earlier. Click any
cell in the list and choose List from the Data menu. You'll see a shortcut menu that
has only one useful item: Create List. As soon as you select that item, you see the
window shown in Figure 1-18.

A e C D
1 Year Region Product Sales Createl_l.st

QDDSINOHhcast _IArca rugs  $47.024.40 y -
2005/ Nurtheasl Arearugs | $21,795.71 || Where isthe data for your it?
JUUG Mortheast Arearugs  $11H25.¢¢ [=sap1:40851 EY|
2004 Mortheast Flacemats  $18,373.48 W By list has hearders
N4 Mortheast Shprovers $14,799 90
2004 Mortheast Slipcovers  $3602.82 K Cancel
2005 Mortheast Slipcovers  § 542915 Q
2003 Northeast Towels $46,287 41
2005 Maortheast Towels $ 254417
2006 Mortheast Towels $53.738.05
2004 Morthwest Placemats  $44,967 .32
2004 Morthwost Slipcovers $41,433.50
2005 Murlbrewest Tablecloltes $43,008.21 s
2UUE Morthwest | ablecloths $12,167 81
2007 Morthwest Tablecloths $20,743.80
N4 Nnrthwest Trvels $58.771 R4
18| 2006 Morthwest Towels $43,000.28
19| 2003 Southeast Arearugs  $11,63533
20 2006 Southeast Arearugs  $34,752.22
21| 2003 Southeast Placemats  $40,304 51 =
W 4 » nyRegional Product Sales ;| « | gl

ey
ElRERRER ][

Figure 1-18: If you take the advice given in this chapter about setting up
lists, your list will have headers.

Confirm the range address of your data, and if necessary correct it (you can
drag through the correct range on the worksheet). Accept or correct Excel's guess
about whether your list has headers, and click OK. You'll see the result shown in
Figure 1-19:

Figure 1-19 shows that Excel automatically adds the following elements to your
list:

* Filter drop-downs (so you don't have to select AutoFilter to get
them)

* A border around the outside of your list. This border might help you
analyze the data more effectively, but I can't think how.

* A row where you can enter a new record. You can do this at the bot-
tom of any list, but this row has an asterisk.
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* List headers, if you didn't supply them yourself. The headers get the
names Columnl, Column2, Column3 and so on, so it's a good idea

to specify them before you formally create the list.

* A total row, which you can toggle on-and-off (it's off at first). This
can be a time-saver, so let's look at it a little more carefully.

a | 5 IEEEN D [l &F | [T
1 [Year v|Region ~|Product »|Sales > =
2| 2003 MNortheast Arearugs | § 4792448
3| 2005 MNortheast Arearugs | $ 21,798.71
4 | 2008 MNortheast Arearugs | 1182877
& | 2004 Northeast |Placemats | $ 18,378.48
6 | 2004 Mortheast  Slipcovers $ 14,799.80
7| 2004 MNortheast |Slipcovers | $ 36402.82
8 | 2005 MNortheast Slipcovers | $ B5429.15
9 | 2003 MNortheast Towels $ 4628741
10| 2005 Mortheast Towels $ 254417
AN 2006 Mortheast ITDWE|S _l $ 53,738.05
22| 2005 Southeast Placemats | $  B5,223.38
23| 2004 Southeast Slipcovers | $ 31,801.87
24| 2004 Southeast Tablecloths $  4,165.40
2
26| 20 List ~ | 2] Toggle Total Row | | %3 =3 |:@ -'v_l%
1 EDur SO E ST »_}II'.JL,U L= L u,JT L
28| 2005 Southwest Tablecloths | $ 43,836.76
29| 2003 Southwest Towels $ 34755495
30| 2005 Southwest Taowels $ 46,704 .67
31| 2006 Southwest Towels $ 4584113
32 [* =5
33 |Total $536,421.58
34 -
4 4 » »[}Regional Product Sales | « | | W[

Figure 1-19: Rows 12 through 21 have been hidden to make room for

special rows at the bottom of the list.

First, though, note that some aspects of the list disappear when you activate a
cell outside the list. The AutoFilter drop-downs disappear, and the border around the
list, while it stays there, is no longer bold, and the new-record row — the one with
the asterisk — disappears.

Handling the Total Row

So does the List toolbar — disappears, that is. It was shown in Figure 1-19. To get at
the List toolbar, just click inside the list.

25
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TIP: If you still don't see the List toolbar after clicking inside
the list, choose Toolbars from the View menu, fill the check-
box next to List, and click OK.

Figure 1-19 showed the toolbar's Toggle Total Row button. If you don't see
the Total Row as the list's final row, click the Toggle Total Row button, and the
Total Row should appear.

If your list has a column with at least one numeric value, that column
defaults to Sum as its total. A column that contains no numeric value has no
default total. However, you can set it to show Count as its total by following
these steps:

1. Click the cell that would contain a total if its column were not all
text values. In Figure 1-19 that cell could be B33 or C33.

2. A drop-down appears immediately at the right side of the cell.
Click the drop-down to display the totals that are available to you.
If you want to know the number of text values in that column of
the list, choose Count.

By default, the left-most column in your list has the word Total in the Total
Row. You can override this with the cell's drop-down and choosing anything,
including None, from the list.

Using the Totals

There are nine options in the Total Row's drop-down list:

* None: Leave the cell blank.

» Average: Show the mean of the numeric values in the column.
(Because the term "average" is sometimes used to mean different
things, let's be explicit: here, it means the total of the numeric val-
ues divided by the number of numeric values.)

* Count: Show how many values are in the column.

* Count Nums: Show how many numeric values are in the column.
If your column contains 12, 8, B, 27, 365 and Fred, Count Nums
returns 4.
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* Max: Show the largest numeric value in the column.

* Min: Show the smallest numeric value in the column.

* Sum: Show the total of the numeric values in the column. This is
the default total for a column with numeric values.

» StdDev: Show the standard deviation of the numeric values in the
column. I've been using Excel for over 20 years, including the
years since Excel 2003 was released, and I've never seen anyone
use the Total option for standard deviation on a list.

» Var: Show the variance (the square of the standard deviation) of
the numeric values in the column. Getting the variance of a list's
column is even rarer than the standard deviation. Okay, that's less
than zero, but you know what I mean.

Totals in the Status Bar

These options go a little farther than the options you can get from the Status Bar.
What's the Status Bar got to do with it? Well, first, the Status Bar is the horizontal
bar at the bottom of the Excel window, the one that's normally just beneath the
sheet tabs, with the word "Ready" at its left. Figure 1-20 shows the Status Bar.

| Ready CAPS HUM SCRL |

Figure 1-20: If you put a toolbar at the bottom of the Excel window, it
will separate the worksheet tabs from the Status Bar.

The Status Bar can tell you some useful things. Notice in Figure 1-20 that
these abbreviations appear on the status bar:

* CAPS
* NUM
* SCRL

They mean that at the time the figure was created, Caps Lock was on, Num
Lock was on, and Scroll Lock was on. It's a quick way to tell what keyboard
options you've selected. When I press 9 on my keyboard's numeric keypad, and
the Excel window scrolls up a page, instead of putting 9 in the active cell, a quick
glance at the Scroll Bar tells me that I forgot to turn on Num Lock.

But that's incidental to what we're talking about. Try this:
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1. Select a group of cells that contain some numbers — cells that are
adjacent and in the same column (B1:BS5, for example), or the
same row (maybe B2:F2), or that are in a range such as C10:F16.
(This step isn't really necessary but it makes things a little clear-
er.)

2. Right-click anywhere on the Status Bar. You'll see a menu pop up,
with the names of various totals you can choose from.

3. Choose one of the totals — say, Max. The maximum number in
the group of cells you selected in Step 1 appears in the Status Bar.

The same sort of thing happens if you choose any of the six options in the
menu you saw in Step 2. So, what's to choose from if you want a total from a list
(by using the Data = List command, discussed in the prior section) or to see it on
the Status Bar? There are two points to choose from:

* You don't have as many options on the Status Bar. The list totals
give you the standard deviation and the variance. Like me, you
might not regard this as a compelling reason to use a list for cal-
culating measures of dispersion.

» Using the Status Bar, your data don't have to be laid out in a list.
The numbers can be scattered all over the sheet. If you take a
notion that you want the total of 2006 revenue, 2005 inventory
turns, and 2003 EBITDA, just make sure you've selected Sum for
the Status Bar totals (Step 3, above) and then select the cells, one
by one, wherever they are on the worksheet.

TIP: To select several cells that are not adjacent, hold down
the Ctrl key as you click in the cells.

Getting Rid of a List

By "getting rid of a list," I don't mean the data; just the bells and whistles that
Excel adds when you use Create List. On either the List toolbar or in the menu
you get by choosing Data = List, you'll find a Convert to Range command. All
this item does is remove the drop-down arrows, border, and so on — items it
added when you used Data = List = Create List.
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In Excel, a data form is a special kind of window that opens in response to some-
thing you do, such as clicking a custom button. The data form pops up and someone
starts entering data. When he or she is through, the data is saved on a worksheet.
Figure 1-21 shows this situation.

M 4 » ¥ Enter New Data, ||

A | B C D | E F G H —
1 |Year Region Product Sales Enter Sales D;na ' i
2 | 2003 Mortheast  Area rugs $47.924 49
| & | EDDE!NDr‘[heast Area rugs $21,798.71 Year: | zo07 i‘
4 2006 Mortheast  Area rugs $11,82577
5 2004 Nertheast  Placemats  $19,3784g | | Product
| & | 2004 Northeast  Slipcovers | $14,799.90 | | © Towek £ arearugs © Flacemats
| 7 2004 Mortheast Sl?pcuvers $36,402.82  Tablecloths ® S
8 2008 Mortheast | Slipcovers  § 642915
El 2003 Mortheast  Towels $46,287 41 Region [
10 2005 Northeast  Towels $ 254417 * Nw '3 sl
11 2006 Mortheast  Towels $53,738.05 ~ ~
f2 2004 Northwest  Placemats | $44,857.32 B 3z ok i
W= 2004 Morthwest  Slipcovers | $41,433.88
14 2005 Morthwwest  Tablecloths  $43,008.21 S
g5 2008 Morthwest  Tablecloths | $12,167 81
1B | 2007 Morthwwest  Tablecloths  $20,743.80
2 2004 Morthwest  Towels $58,221 64
ElS 2006 Morthwest  Towels $43,009.28
g 2003 Southeast  Area rugs $11,635.33
20 2006 Southeast  Arearugs | $34,782.22
21 2003 Southeast  Placemats  $40,304 .51 =

| di

Figure 1-21: A moderately experienced developer can develop a form
like this in just a few minutes.

What you see in Figure 1-21 is a custom data form. It's one that someone
experienced in Excel constructs and ties to a worksheet, so that when the user hits
the OK button, Excel takes the data in the form and writes it to the sheet. There
are plenty of good reasons to arrange the entry of data with a data form. For exam-
ple:

* Checking the data on the form for validity

* Displaying some fields (or some records) for certain users, and other
fields or records for other users — usually in a context that requires
different levels of security

29
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* Situations where there are so many fields that it's clumsy to display
them all on one form and several tabs are needed. (Excel's Options
form is one example.)

An experienced developer can create and test the form shown in Figure 1-21 in
no time. But Excel provides you with a built-in Data Form that offers some of the
functionality of a custom form. Figure 1-22 shows how the Data Form looks with a
list I’ve used extensively in this chapter. In this case, because the custom form in
Figure 1-21 is pretty rudimentary, the Data Form in Figure 1-22 has much more
functionality than does the custom form.

A | B | B D E F G H I =
1 |[Year v|Region «|Product v|Sales S [ oier New Data
_2 | 2003 Mortheast Arearugs | $4782449
3| 2005 Mortheast Arearugs | $21798.71] |tear  [e007 -] 15 of 30
4 | 2006 Mortheast Arearugs | $11.82577 Heinn] W Mew
& | 2004 Mortheast Placemats | $19,378.49
6 | 2004 MNortheast Slipcovers | §14,788.90 | | Froduct: [Tablecloths _ boete |
7 | 2004 Mortheast |Slipcovers | $36,402.82 Sales:  [z0743.8 .
8 | 2005 Mortheast Slipcovers  $ 6429.15
~ 89 | 2003 Mortheast Towels $46,287 41 = Find Prev
10| 2005 Mortheast Towels $ 284417 -
11| 2006 Mortheast | Towels $53,738.05 _ Fndtiett |
12| 2004 Morthwest Placemats | $44,967.32 Criteria
13| 2004 Morthwest |Slipcovers | $41,433.59
14| 2005 Morthwest Tablecloths | $43,008.21 Close o
15| 2006 Morthwest Tablecloths | $12,167.81
16| 2007 Morthwest | Tablecloths  $20,743.80 |
17| 2004 Morthwest | Towels $58,221.64
18| 2006 Morthwest Towels $43,009.28
19| 2003 Southeast Arearugs | $11,63533
20| 2006 Southeast Arearugs | $34,752.22
21| 2003 Southeast Placemats | $40,304.51 -
M 4 » ¥[yEnter New Data, || | Wl

Figure 1-22: The Data Form's name, on its title bar, is by default the
same as the name of the active worksheet.

Before looking at the individual capabilities, notice how difficult it is to create
the form:

1. Click in a cell in your list.

2. Choose Form from the Data menu.

That's all that's needed to get the form you see in Figure 1-22. It's a good way
to impress someone who doesn't know that Excel can do this for you.
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Now, here's what you or your data entry person can do with the data form:

You can tell how many records are in your list, and which record is
active, by looking just above the New button.

Move through the records using the scroll bar (just left of the but-
tons).

Establish a new record at the bottom of the list by clicking New.
Delete the current record by clicking Delete.

Revert to original values that you've edited in the current record, by
clicking Restore. The Restore button is dimmed until you make a
change to a value. You can't Restore a record that you've Deleted.
(Instead, close the data form, and then close the workbook. Do not
save changes when you're prompted. Lastly, re-open the workbook.)
Go to the prior record, by clicking Find Prev (short for previous). If
you have established selection criteria by clicking the Criteria but-
ton, this takes you to the closest prior record that qualifies according
to the criteria.

Go to the next record, by clicking Find Next. The criteria act in the
same way as with Find Prev, except that Find Next takes you to the
following qualifying record.

Establish selection criteria, also known as filters, by clicking the
Criteria button.

Close the Data Form by clicking the Close button.

If you click the Criteria button, you see something very similar to the data
form; the main difference is that the boxes will be empty. Type the values that you
want to select in the appropriate boxes: for example, to select the Northwest region
and the Towels product, type Northwest into the Region box and Towels into the

Product box.
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Chapter 2
P1vot Tables

The Purpose of Pivot Tables

Getting Data Summaries

Building Pivot Tables

Too Much Information: The Data Cache

Using Named Ranges as Data Sources

start putting them to work as sources of data. Chapter 1 mentioned some of

the ways that you can use lists to set up financial analyses that are more
sophisticated than just looking at transactions. One of those ways is by means of a
pivot table. A pivot table is the most powerful and flexible method of data analysis
and synthesis available in Excel.

Now that you've taken a look at lists, as Excel defines them, you're ready to

The Purpose of Pivot Tables

We're often confronted with a mass of data that probably has some interesting pat-
terns in it — but there's so much detail that it's almost impossible to tell the forest
from the trees. A 50-page detail report of expenses by cost center is hard enough to
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deal with, but it can become a real headache if someone needs to total up the costs
by vendor.

That's the sort of thing that pivot tables are intended to do for you. You build a
pivot table on a set of detail records, and Excel summarizes the data in whatever
way you specify. Any field in the data — for example, cost center, vendor, PO num-
ber, invoice month, and so on — can be used to summarize the information.

And the pivot table can be thought of as either an ad hoc report, ideal for data
snooping, or a standard periodic summary. You can change the summary categories
from, say, month of the year to another variable such as vendor name just by drag-
ging a button on the worksheet. Your summaries can be any statistic you wish,
although it's likely that you'll find yourself arranging for sums, counts and averages
more often than the others available.

Since Excel 2000, pivot tables have come with another feature, pivot charts.
Although pivot charts have some useful features, they tend to be less flexible than
standard Excel charts, and therefore this book does not cover pivot charts in much
detail. I believe that you'll be a good bit better served if you base standard Excel
charts on pivot tables, as shown in Chapter 4, than if you use pivot charts.

You might have noticed that I'm referring here to "pivot tables," not
"PivotTables." The latter usage, which jams the two words together, is a neologism
brought to you by Microsoft. They're a Microsoft product and Microsoft can call
their products whatever they want. But I don't have to compound the felony, and I
think that "PivotTable" is jarring, and this book calls them "pivot tables."

I may as well be up front about this: I'm a big fan of using pivot tables to ana-
lyze information such as financials and operational data. Pivot tables have some
problems, including a few that make me nuts (for example, recent versions of Excel
have forced the user into pivot charts if they want to show pivot data summaries
graphically). But I think you'll find, if you haven't already, that pivot tables' advan-
tages outweigh their drawbacks by a long chalk.

There are so many advantages, in fact, that I'm going to spend the first several
sections of this chapter describing some of them, before I get into the issue of actu-
ally building a pivot table. So, if you're impatient to get on with it, skip to the sec-
tion named Building Pivot Tables.
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Getting Data Summaries

As part of its discussion of lists in Excel, Chapter 1 discussed data summaries, or
totals. 1 don't much care for the term "totals," because it implies summation. In ordi-
nary English, when you total some things, you add them up. So, although Excel's
developers and marketers probably found the term "total" convenient, it's mislead-
ing. There's much more you can do with what I'll call summaries than just look at
numeric totals.

Data Summaries

A data summary isn't part of how the structure of a pivot table is defined. It is the
way that you choose to look at the data in the pivot table. The pivot table in Figure
2-1 is one in which the user has chosen to look at numeric totals — the data will
look familiar to you if you've worked your way through Chapter 1's material on lists.

A B ¢ | o | E | F | & | H | ¥ | =
1 |Sum of Sales (=i
2 |Region v |Total
3 [Mortheast $ 261,128.96
_4 |Morthwest $ 263,551 65
5 |Southeast | §128,882.69 =
£ |Southwest § 233,002.00
7 |Grand Total || $ 886,665.29
8|
9
10 X
4 4 » ¥[}Regional Sales Totals , | 4 | | W[

Figure 2-1: This pivot table shows the sum of the sales for each region.

Sometimes you'll be interested in the average of the sales for each region (or
product, or accounting period, or sales manager, or whatever). Figure 2-2 shows the
difference due to looking at averages instead of sums.

Notice that the pivot tables shown in Figures 2-1 and 2-2 don't differ in struc-
ture. They both show information about sales dollars according to sales region, and
each region appears in a different row of the pivot table. The main difference
between the two pivot tables is that one shows sales dollars as sums, and the other
shows sales dollars as averages.
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A B 5 5 = 5 o =
1 |Average of Sales Tl
2 |Reqgion - |Total
_3 |Mortheast 2611290
4 |Northwest 37.650.24
5 |Southeast $21.497.11 =
£ |Southwest $33,286.00
7 |Grand Total $29 555 .51
8
| & |
10 X
4 4 » w[yRegional Sales Averages;|<| | ’”_

Figure 2-2: The structure of the pivot table is unchanged by showing

averages rather than sums.

Besides sums and averages, there are several other summaries that you can

choose. In the context of reporting sales figures on a region-by-region basis, these
other summaries are listed below.

Count: The number of values that Excel finds in the data source.
Continuing the current example, the pivot table could show you the
number of records for each region. This summary does not distin-
guish between numeric and other types of values, such as text.

Max and Min: The largest (or the smallest) numeric value that Excel
finds. In this case, you would see the numerically largest sales value
recorded for each region, or the smallest, depending on whether you
choose Max or Min.

Product: The product of all the values Excel finds for a given region.
Not to say that one doesn't exist, but I've never seen this summary
put to a good use.

Count Nums: The number of numeric values found for each region.
But if you have a mix of numeric values and other types of values in
the same field — which is the only reason for using Count Nums —
then there is some question whether you've defined the field properly.
StDev and StDevp: The standard deviation of, in the present exam-
ple, the sales figures found for each region. There's an argument for
getting these summaries if you're developing a confidence interval on
sales for each region, or if you're preparing a statistical process con-
trol analysis (most often used in manufacturing applications). The
difference between StDev and StDevp depends on whether you
regard the values as coming from a sample (use StDev) or a popula-
tion (use StDevp).
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* Var and Varp: Var is the square of StDev, and Varp is the square of
StDevp. Both are measures of the variance of a set of numbers. It's
possible to argue that these summaries would be useful if you're
working on an Analysis of Variance. But it's a stretch.

These data summaries apply only to the field that you choose to treat as a data
field. A pivot table's structure consists not only of data fields, but also of row fields,
column fields, and page fields.

We've established that the data summary you choose doesn't determine the
structure of the pivot table. In Figures 2-1 and 2-2, for example, all the information
is in the same cells; the only difference is the summary values that appear in cells
B3:B6. What does make a difference to a pivot table's structure is how you use row
fields and column fields.

Row Fields

A pivot table's row field contains a different value in each row, and the pivot table
reserves one row for the field's name. So, in Figure 2-2, the row field occupies cells
A3:A6, with the Region field's name in cell A2. The values you see in cells A3:A6
are called items.

A pivot table can handle thousands of items (the upper limit has increased with
every release since Excel 95). In theory, you could have a field called Age In Weeks,
which could take on every value from 1 to, say, 4680, and it could be a field in a
pivot table, with one row for each week. Of course, while there might be a situation
in which you would want to see a summary value for each of 4680 items in a field,
it's hard to imagine a realistic one.

NOTE: There's another type of field that you can put in a pivot
table called a column field, discussed in its own section later
in this chapter. Instead of a different item in each row, a col-
umn field has a different item in each column. Virtually all of
what this section says about row fields applies to column
fields as well. However, because of the way we're used to
viewing tables, it's usual to put things such as subtotals in
their own rows rather than in their own columns, and that
implies the use of a row field rather than a column field.
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Multiple Row Fields

A pivot table such as the one shown in Figure 2-2 can give you a good, quick
overview of your data (and you can also use it for a giggle test: if you can look at
the pivot table without giggling, chances are that you've acquired and accounted for
the underlying transactions correctly). Often, though, you're interested in more than
just one field. Figure 2-3 shows a pivot table that summarizes Sales by Region and

by Product.
A | B C | A=

1 |Sum of Sales

2 |Region ~|Product w|Total
_3 |Mortheast ArEa rugs $ 8154897
4| Placemats $ 1937849
| 5] Slipcovers $ 5763187

Towels $ 102 569.63

7 |Northeast Total $7R1 178 AR
8 |Morthwest Placemats $ 4496732
9 Slipruvers $ 4143359
10| Tablecloths $ 75919.02
1 Towels $101,230.82
12 | Morthwest Total $ 36355165
13 |Southeast Brea rugs $ 4b,387.95
14 Placemats § 4652786
15 Slipcovers $ 3190187
16 Tahlecloths

17 |Southeast Total $124817.28
1R | Snuthwest Area nigs 102855
9] Placemats ¥ 3232212
20| SlipLuvers $ 2851282
21| Tablecloths $ 40,006.76
22 Towels $127301.75
23 |Southwest Total £ 233,002.00
24 earuns Sum_ | § 170 Heb 17
25| Placemats Sum | § 143,195.79
26 Slipcovers Sum | $1509,480.15
2] Tablecloths Sum | $119,756.50
28 Towels Sum $331,102.30
29 |Grand Total $982499.89

gl

1« » )\ Product Sales within Region , | 4 |

| NN

Figure 2-3: Notice that Region now has subtotals, identical to the

regional totals in Figure 2-1.

With the Regional subtotals, you can see both the total for the Product within
the Region, and the total for the Region. I'll get into this issue more in the section on

building pivot tables, but for now you should know that:
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Excel provides subtotals automatically when you call for two or
more row fields. The automatic subtotals are for the outer row field
or fields (in Figure 2-3, that's Region).

The default subtotal is Sum (for most numeric fields; the default is
Count for a field that has even one text or date value), but you can
get any summary statistic listed above in the section titled Data
Summaries.

You can suppress subtotals entirely if you want, and this can be best
if you're basing a chart on a pivot table.

Subtotals are not automatic for the innermost row field (in Figure 2-
3, that's Product). You can, however, get what Excel calls block

totals for the innermost field. Figure 2-3 gives an example, in cells
C24:C28.

Sorting a Row Field's Items

Many of the tasks you handle with values that are stored on the worksheet in the

normal fashion

can also be done with data in a pivot table. But you usually have to

take a somewhat different route if you're using a pivot table's fields.

One example is sorting. To sort values in, say, a list, you select a cell in the list
and choose Sort from the Data menu (see Chapter 1 for more information.) But you

take a different

approach, depending on the Excel version you're using, to sorting

items in a pivot table. Figures 2-4 and 2-5 show how this is done.

[ A B c G | H =
1 |Sum of Sales i
2 |Region »|Total
3 |Nurtheast $261,126 96
_4 Northwest | $263,551 65
5 ESDutheast 1$128,982 66 b - =
6 |Southwest $233,002.00 * Automatic um - e
/_|Grand Total_| 886 685 29 Mo Ll [ |
5 A5 Max Advanced... | —]
o Product - :
o
1| I Show ikems with no data
12
al "
W 4 » w\Regional Sales 1otals /| « | I a1
Figure 2-4: You can take care of several pivot field tasks by starting

with Field Settings.
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1. Right-click any cell in a row field (or in a column field or page
field, which I talk about later on in this chapter). Do not select a
data field first if you want to set sorting or top ten options.

2. Select Field Settings from the shortcut menu.

3. The PivotTable Field dialog box appears, as shown in Figure 2-4.
Click the Advanced button.

4. Figure 2-5 shows your options as to sorting and top ten settings.
Select the options you prefer and click OK.

[ A B c D E | F | G | H =

1 Sum of Sales = 3
2 |Region |Total

3 [Nurtheasl $261,126 96

4 ‘Northwest |$262,551 65

_5 |Southeast  |$126,082.68

6 |Southwest |$233,002.00/] poge fickd options
! |Grand Total |$886.66529|] «
_6 | r
31 =
10 )
T' AukoSort opbions Top 10 AustaShow
12|
RE] “on
14| show: [1op -] [0 =
%‘ Uising Ficld: Using Ficld:
E IReg’on :J |Sum of Salec ﬂ |
] -_nx Cancel
18] =
W« » »)\Regional Sales 1otals /| 4| I il

Figure 2-5: The Using Field dropdown is enabled if you select the
Ascending or Descending sort.

(The top ten options are the same as those described in Chapter 1, in the section
titled Using AutoFilter Options.)

The sorting options have these effects:

* Manual. You can drag a row field item up or down into a different
row (or a column field item left or right into a different column).
The associated data field items will follow their row field item. All
you have to do is click a row field item, move your cursor over the
cell's top or bottom edge, hold down the mouse button and drag.
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* Ascending. The row field items will sort themselves automatically in
ascending order. If you add a new record to the pivot table's data
source, and that new record contains a row item not yet in the pivot
table, Excel adds it to the pivot table in ascending row field order
(but not immediately: see the section on the Data Cache later in this
chapter).

* Descending. This option has the same effect as choosing Ascending,
except that the order in which the items appear in the pivot table is
reversed.

The Using Field dropdown is disabled unless you choose the Ascending or the
Descending sort option. Then, it becomes enabled, and you can choose which field
— either the selected row field or the data field — to use as your sort key.

NOTE: If you choose to use the data field as the sort key,
Excel will sort by the data field's grand total across columns.

To summarize your sorting options:

* You can sort manually, by dragging a row field item.

* You can sort automatically, either ascending or descending.

* If you choose to sort automatically, the sort key can be either a row
field (e.g., 2000, 2001, 2002, etc.) or a data field (e.g., $50,285.17 ,
$170,545.02, $180,907.69, etc.)

TIP: You can also sort a pivot table by selecting a row field
item and choosing Sort from the Data menu. However, if you
do it that way, the field will not automatically re-sort when it
encounters new data.

Grouping Row Values

What if you want to use a numeric variable as a row field? So far, this chapter's
examples have used text variables as row fields: Northwest and Southeast, for exam-
ple, are items in the Region field, and the Product field has items like Towels and
Placemats.
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But you might have an interest in an analysis that uses Sales as a row variable.
For example, you might want to know how many records in the underlying data source
have between $0 and $10,000 in sales, between $10,000 and $20,000, and so on.

But Sales is a numeric variable, and can easily have thousands of distinct values
— you don’t want a pivot table to give you a different row field item for each distinct
value of sales dollars.

The solution is to group on the numeric field Sales so as to create categories of
values. Figure 2-6 shows a pivot table with the row field Sales first ungrouped, and
then grouped.

| A B G|y o E F 2 I G I
1 [Sum of Sales Sum nf Sales ‘m
_2 |Sales - |Total Sales ~|Total

3 (% 10855 |F 102855 1028.55-1102855 | $ 20,390.62

4% 254407 ¢ 254407 11028.55-21028.55 |$ 90,551.10

5|% 418540 (% 4,18540 21028.55-31028.55 | $ 50,311.53

6% B2IS|$ BYX2IIS JI20.55-41020.55 | $210404.49 -
7% 6429.15(% 642915 41028.55-51028.55 | $403,012.86
A |$ 1MAISI7(F 11,RI500 51020 55-R1020 55 [ §111.950 A9
ﬂ $ 1182577 | § 11.825.77 Grand Total 886,665.29

10| § 1216781 |$ 12,6781
% 14.799.80 [ $14.799.90
| $ 1937849 | $ 19,378.49

A3 % 20,4380 [ $ 204380
4% 1179871 [$ 2179871

W hllu}:_s'al‘g; l::atltlagn:lleg:r‘lil | W[

Figure 2-6: The first pivot table's analysis is completely redundant.

See the section named Grouping on a Purely Numeric Field, later in this chap-
ter, for information on how to make the grouped pivot table more readable, and
interpretable, than it is in Figure 2-6.

NOTE: It's unfortunate, but when you group on a numeric field
that would normally have a special format such as Currency
or Accounting, the dollar signs and the thousands separators
are lost in the process of grouping. (What actually happens is
that the numeric values are converted to text labels such as
10000-20000, and Excel isn't sophisticated enough to apply
the numeric format to a text value.)

There are other grouping methods available for a numeric row field. For exam-
ple, dates and times are numeric fields in Excel. Figure 2-7 has another pair of
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before-and-after pivot tables that show how you could group individual dates into

months.

A B | D | B E e =
1 |Sum of Sales Tl
2 |Sales Date «|Total
3 1/15/2007] $47 924 49
E fEA1A004| $341 401 87 Sum of Sales
19| W272007| $27,172.85 Sales Date_«|Total
20| 7/31/2007| $19,3768.49 Jan $47 924 48
2| 8/1/2007| $44 96732 Feb $84 444 17
22| 0/5/2007| $24,752.22 Mar $132,764.04
23] 8/7/2007| $21,798.71 Apr $57424 76
24| Bf31/2007| $34,755.95 Mary $36,402 82
25| 9/11/2007| $28,512.82 Jun $93,068.32
3| 9/15/2007| $48,287.41 Jul $78.453.2
27| 10/17/2007| $43,009.28 Aug $136,274 .20
28| 10/1B/2007| $40,304.51 Sep $74,800.23
29| 10/21/2007| $2,544.17 Oct $85,857 96
30 11/6/2007| $58,221.64 Nov $58,250.18
?] 11/20/2007]  $1,028.55 Grand Total  ||$886 665.29
32 |Grand Total  |$886 665.29 =
= -
4 4 » il Monthly Sales <] < | | o[

Figure 2-7: Compare, for example, the two September sales in the first

pivot table with the one grouped value in the second.

There are plenty of ways to aggregate dates and times — for example, by some
number of days that you specify (such as seven for a weekly analysis), or by quarter,
or by year, or by month within year, and so on. And you can combine the grouping
factors: for example, quarter within year.

TIP: One problem with the grouping feature is that it can't
handle missing data. If you have dates as your row field's
items, and if even one of them is missing, Excel will display
the error message Cannot Group That Selection. There's no
help for it, other than to delete the record with the missing
value, or to make a value up. If you do either one of those,
start over with a new pivot table: the old pivot table will
remember that there was a problem, and won't believe you
even if you make up a value and refresh the data cache (see
the section on the Data Cache).
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Pivoting a Pivot Table

This book hasn't yet discussed what's pivotal about a pivot table. The term "pivot
table" is more marketing hype than functional description, but it's true that pivot
tables can and do pivot.

TIP: Excel and Microsoft insist on the term "pivottable" without
the space. If you're looking up a pivot table's attributes in a
Help document, or at a Microsoft web site, you might want to
search both for "pivot table" and "pivottable”.

Figure 2-8 shows a pivot table, before and after pivoting.

! s 8 G 0 3 E £ | = | 2t SIS o
1 [ Surn of Sales Surmn of Sales [Region | nl
2 |Reqion » [ Tulal Moriheast Mortbnaes Suuthieas! Soultwesl [Grand Tolal
3 [Nnrtheast BIA112R90 | |Tntal $761,19R A6 $ 763,551 G5 | § 19A,9R7 AR $ 933,007 NN | $ BAR AR5 79
4 |Nnrthwest £ 903,501 A5 =
5 |Snutheast £ 178,887 AR
A |[Snuthwest | § 233007 00
7 [Grand Total [ § ARG GRS 29
8| -
W 4+ )y Regional Sales .| 4 | | ol

Figure 2-8: The second pivot table is identical to the first, but the row

field has been pivoted so that it's a column field.

Figure 2-8 is shown only to introduce the notion of pivoting a pivot table. You
would seldom create a pivot table with a row field and then pivot the table so that it
became a column field (unless you're using Excel 97 and you want to group a col-
umn field: if so, first group it as a row field and then pivot it so it's a column field).

To pivot the table as shown in Figure 2-8, you would take these steps:

1.

3.

Move your mouse pointer over cell A2, labeled Region. The pointer
turns to crossed double-arrows.

. Hold down the mouse button and drag the Region label to the right

of cell Al, labeled Sum of Sales.

Release the mouse button. When you do so, the table pivots.

In fact, the pivot capability is not one that you'll have much use for. On rare
occasions, ['ve had reason to pivot a table, to change it from a table with two row
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fields to one with a row field and a column field (see Figure 2-9 for an example), but
the only other reason I can recall had to do with creating a figure for a book.

A B | C | D | E F 6 | H | 1 =

Sum of Sales |Region | =l
Year ¥ |MNortheast Morthwest Southeast Southwest Grand Total
20030 § 04211.00 § 51053084 § 3475505 | §180,007.60

2004| % 70581.21 $14462255 § 3606727 $251,271.03 T

2005| % 3077203 % 43005.21 % 622335 % 90541.43 | $170545.02

2006) $ B55E3.82 5 5517709 § 3475202 § 78,163.25 | $233 656,35

2007 |$ 20,743.80 $ 2954137 | § 50.2B85.17

Grand Total | $261.128.96 $26355165 $123962.66 $233,002.00 | §556.665.29

1 4 » M} Annual Sales by Region / | « | | W[

Figure 2-9: The blank cells represent missing data: for example, the
Northeast region had no sales during 2007 .

It's true that pivoting a table has limited usefulness, but there are plenty of good
reasons to plan the design of a pivot table as shown in Figure 2-9. That structure can
be more informative visually, and it turns out to be a good way to design a table for
use with Excel's Lookup functions, such as VLOOKUP.

Column Fields

Column fields give you the same functionality that you get with row fields: they're
just oriented so that each item occupies a different column, instead of a different
row. In particular, with both types of field you get:

* Subtotals (optional, and recommended only if you have more than
one column field, or more than one row field)
* Grouping
* Sorts and Top Ten
The main differences between column fields and row fields are their orientation
on the worksheet, and the relatively small number of columns on the worksheet
available to handle a column field's items.

The choice of whether to orient a field as a row field or a column field is usual-
ly a matter of personal preference, and it might depend on the kind of data in the
field. For example, suppose that the field in question contains dates or times. We're
accustomed to seeing dates and times progress from left to right in tables and charts,
so you might decide to arrange the pivot table so that, say, January's dollars appear
in Column B, February's in Column C, March's in Column D and so on, as in Figure
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2-10. (Yes, you could use a data table in the chart, but it wouldn't be formatted as

currency.)
| T | M S G | e W - gL . o
"1 |Sum of Sales [Sales Date +| |
Grand

2 Jan Feb Iar Apr Iy Jun Jul Sy Sep Ol Mo Tulal

2 |Tula| $47,924 $84.444 $132,785 $57425 $36.403 $93,0688 $78.453 $136,274 $74,800 $85,858 $59,250{$B46 665

4

w2

A

7 || #140,000 <

8 11 $120000 A L v

i LA

0| F1nn.oon oR— <

1| $80,000 4 X // — e

}; $60.000 e e - e

et 1B | L T 4
T1a|  #awo0 S 4

1511 $20,000

16

el $0 . ! |
el Jan Feb mar Apr May Jun Jul Alg Sep oct oY

1]

e v
4 » wlyMonthly Sales Chart, ] | 2l

Figure 2-10: Your figures could be in rows instead of columns, but the

chart is easier to compare to the worksheet data with this
orientation.

Another reason to orient a field as a column rather than as a row is that you
might have two fields to show, and you'd like to use one as a row field and the other
as a column field, as shown previously in Figure 2-9.

TIP: You can make a pivot table as complicated as you wish.
For example, it's entirely possible to build one that has multi-
ple row fields and multiple column fields. But always keep in
mind the needs and capabilities of your clients. A lot of good
research done during the 1970s showed that a user's ability to
mentally process the data in a table plummets with every
added layer of complexity.

Page Fields

A page field in a pivot table is a structural element, as are row fields and column
fields. But its use is conceptually different: you use a page field to select which
records the pivot table will display. Figure 2-11 shows an example of three pivot
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tables. Each has a page field, Year, and each uses the page field differently: one
shows all records, one shows only the records from 2006, and one shows only those

from 2007.

A
Year Jca

B C

bl

Region ~|Total

1
i
3 |Sum of Sales
4
gl

|Northeast $261,128.96

6 |Nortwest | $263,551 65
_7 |Doutheast F 120 452 by
8 |Southwest $233,002.00

9 |Grand Total | $ 5886 6529

10

i« » »[yRegional Sales by Year / |« |

0 E ‘
[¥ear |2005 =
Sum of Sales
Region ~|Total
MNortheast $ 64,06382
MNorthwest $ 55,177.08
Southeast § 34,0227
Southwest § 78,163.25
Grand Total | $233,656.38

F G H
Year 2007 -
Sum of Sales
Region ~|Total
MNarthwest $20,743.80
Southwest $29,541.37
Grand lotal | $5U,285.14

Figure 2-11: You use a page field to filter for only those records that

belong to a particular item in that field.

As I mentioned in Chapter 1, even though you can use lists and Excel's filters to
analyze one field in terms of another field, your first thought in these situations
should be of pivot tables. They make it very easy for you to focus on one item of a
field, if you treat that field as a page field. All you have to do to change from one
item to another is use the page field's dropdown arrow (see Figure 2-12).

A | B | E; | D E
1 |vear [0 -
2|
3 |Sum of Sales 2003
_4 |Region hd 2004
5 |Northeast 2005
_E |Morthwest gggi
7 |Southeast
8 |Southwest
_ 9 |Grand Taotal
10
11
2 ok | Canicel |
13

W 4 » W)} Regional Sales Totals £ | « |

Figure 2-12: Select the item you want to filter for and then click OK.

You can use more than one page field at once, as seen in Figure 2-13.
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A B G EEN D EE T =
1 [Product Towiels - El
2 |Year 2006 -
3
4 |5um of Sales
5 |Region | Total _
B |Mortheast $ 53.738.08
7 |Morthwest $ 43,009.28
8 |Southwest $ 45841.13
9 |Grand Total | § 142 58846
|<1D¢ » n} Region Totals by Product, Year | « | | Wl

Figure 2-13: The page fields act as though they were connected by
ANDs.

In Figure 2-13, you see the sales of Towels during 2006 in each Region
for which qualifying records exist..

In my own business, I have several clients who want to see financials, par-
ticularly operating expenses, on a monthly basis — but they prefer not to have
to manipulate a pivot table's page fields to choose a date range. So we provide
an Excel workbook for each fiscal year, with a different worksheet for each
month. On each worksheet is a pivot table (and a chart based on that pivot
table) that shows the expenses for that month.

Some clients appreciate this approach, because they don't care to fool
around with drop-down arrows to select a different date range: it's easier to
select a different worksheet tab. However, although all the pivot tables are
based on the same data source, we do not base the pivot tables on one another
(look ahead to Figure 2-14 to see how you'd get a start on doing that). The rea-
son is discussed later in this chapter, in the section named Page Field
Problems.

Building Pivot Tables

Now that you've looked at some of the features of pivot tables, it's time to
build one. The simplest way is to start with a list, as seen in Figure 2-14.
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In Figure 2-14, you see the list that several pivot table examples in this chapter
are based on. To build a pivot table from that list, take these steps:

1.

A

Click any cell in the list. This step isn't necessary but it makes things
casier.

. Choose PivotTable and PivotChart Report from the Data menu to

start the Pivot Table Wizard.

. For this example, accept the default choices of Microsoft Excel List

or Database, and PivotTable. Click Next to see the wizard's second
step.

. In Figure 2-15, notice that the list's address appears in the Range

box. If you begin by selecting a cell in the list, Excel finds its
boundaries for you; otherwise, you have to supply the address your-
self. Verify the address and click Next to go the third and final step
of the wizard, shown in Figure 2-16.

. You'll often want a pivot table to appear on a new worksheet, to

avoid the visual clutter of the list, so just click Finish. (But see a Tip
on that topic later in this chapter.)

B ¢ | b E | r |G|

Sales Date Region
‘r.F15fEDD?_|NDrtheas;t Area rugs
2/11/2007 Northeast Slipcovers  $14,799.90
212172007 Southwyest Towels
2P0 Southeast Area rugs
228/2007 Morthwest Tablecloths $12,167.81
3M17/2007 Soulhwesl Placermats | $32,322.12
3f24/2007 Southwest Towels

| J =
PxX .

Product  Sales PivotTable and PivotChart Wizard - Step 1 of 3

£47 921 19

‘Where Is the data that vou wank to analyze?
 Microsoft Office Excel kst or database!

" External data source
" Multiple consolidation ranges
" another PivotTable report or PrvotChart report

$45,841.13
$11,535.33

$46,704 67

3/20/2007 Morthcast Towcls $53,738.05
4f13/2007 Southeast Tablecloths $ 4,165.40
4/28/2007 Morthwest Slipcovers  $41433.58
Af28/2007 Mortheast Arearugs $1182577
0/30/2007 Mortheast Shipcovers  $36402.52
RARINONT Morthwest Tablecinths $43.008 21
B/22/2007 Southwest Tablecloths $43,836.76
6/22/2007 Southeast Macemats $ 6,222.05

\What kind of report o you wank ko creste?
* PivulTalle
" pvotChagt report (wath Pivot | able report)

e o o

7| 72172007 Svulheast Slipuvers | $31,901 87 Cancel_| [[ee> | oo |
18 PN Nartheast | Shocrvers F R4UY 15 X
M 4 b HRaw Sales Data, |« | ’“‘M

Figure 2-14: You need a list structure if you want to build a pivot table
from figures on a worksheet.
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.. 6 el o.oD | E F | | S | =54
1 iSales Date Region Product Sales H |
2 1158000 fiNortheast  Area rugs FArgM Ay E @El

i:: 2/11/2007 Northeast Slipcovers | $14,799.90
_4} 221/2007 Southwest Towels $45,841.13 )
_5 1 22712007 Southeast Arcarugs | $11635.33 ¢ -
b} 2/28/2007 Northwest Tablecloths | §12,167.81 | Concel | <ot [[ met> | pen |
L: AT0N07 Suwttweest Placermals | $37 327212 i
_0 ) 2424/2007 Southwest Towels 546,704 67
9, SAMF20UF Northeast | owels $563,/38.05
10} 471372007 Southeast Tablecloths $ 4,16540 }
A1) 41282007 Northwest Slipcovers | $41,433.59 |
i 442072007 Morthcast Arcarugs | $1182577)
13} 5/30/2007 Northeast Slipcovers | §3640282 |
14} RAR2ONT Nortteeest Tatlecloths | $43.008 21 3

A5} 6/22/2007 Southwest Tablecloths | $43,036.76 1
16} BALEA0US Southeast Placemats § 522335
i‘ 7212007 Southeast Slipcovers | $31,901.87 )

1/ 742712007 Nnrtheast S{inr.n\mm ® R479154 -
10 4 » ¥\ Raw Sales Data, | ¢ | i

Figure 2-15: This is why it's smart to start by selecting a cell in the list.

B 5 | ¢ | b En| F | T | |

[Sales Date Region  Product  Sale S uugu o e S A P ?
| 11165200 I_[Northeasl Arearugs | $47 —

I

2
_3 | 2112007 Mortheast  Slipcovers | §14
_4 | 2172007 Southwest Towels £45
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Figure 2-16: Click the Layout button if you're more comfortable with the
Excel 97 method of designing the pivot table.

When the wizard closes you see the table schematic and the field list shown in
Figure 2-17.

At this point you decide how you want the pivot table to summarize your data.
Suppose that you wanted to view the sum of sales dollars for each of four regions. In
that case:

1. Click and drag the Region button in the PivotTable Field List box
into the area on the worksheet labeled Drop Row Fields Here.
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2. Click and drag the Sales button from the PivotTable Field List box
into the area on the worksheet labeled Drop Data Items Here.

7| =i O Sl = = A ) [ SO
itop Paoe Fields Here I

PlvotTable Fleld List * X

Drag items ko the PivotTable report

ool B

=]

-

g s
i

[ Sales Date
EI Region

=] Product
[ 3ales

SEERRE

I [T W

4 4 » ) Sheet2 ! Raw Sales Data |« | | W[

Figure 2-17: The schematic for the pivot table appears on the work-

sheet (prior to Excel 2000, it was on a dialog box).

TIP: The moment that you drag a field into the Data area,
Excel assumes that you're through designing the table and it
removes the schematic from the worksheet. It's usually a
good idea to add row fields (and column and page fields too,
if you're using them) before you put a field in the Data area.

Creating Multiple Row Fields

Earlier in this chapter (specifically, in Figure 2-3), I showed a pivot table that breaks
down Sales dollars by Region and by Product. That's easy to do: after adding
Region, and while the PivotTable Field List box is still open, take these steps:

1. Click the Product button.

2. Make sure that Row Area appears in the dropdown at the bottom of
PivotTable Field List box.

3. Click the Add To button.
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If you prefer, you can add any field to the pivot table by means of the Add To
button, rather than dragging a button onto the table schematic. However, if you want
to remove a field from a pivot table, it's best to click the grey button with the field's
name on it, and drag it away from the table. When the mouse pointer grows a styl-
1zed red X, release the mouse button.

TIP: You can show or hide the PivotTable Field List any time
by using its toggle button on the PivotTable toolbar. Unless
you've customized that toolbar, the toggle button is its right-
most button. Or, right-click in the pivot table and choose Show
Field List from the shortcut menu.

Dealing with Subtotals

Referring again to Figure 2-3, notice that the Region field has a subtotal across
Product for each Region item. If you don't want those subtotals, take these steps:

1.

Select any Region item, such as Northwest, and click the Field
Settings button on the pivot table toolbar. Or, you can right-click any
Region item and choose Field Settings from the shortcut menu.

. The PivotTable Field dialog box shown in Figure 2-18 appears.

3. Click the None button under Subtotals, and then click OK.
| A | B (3 | D T I T |

1 |Sum uf Sales

2 [Rewon__w[Prodil [T
3 |Mortheast Area rugs F B1,54897 ) - —
4| Ilaremats § 1amay | [N Reoo = |
R Slipcovers § 57.63187 subtatal Ceanel

6 | Towels 102,5669.63 & Anlmnali S

7 |Mortheast Total 261.128.06  Custom m:: i thie

8 |Murlineest IPlaernals 44,567 32 7" Hone iy el |
9 | Slipcovers F 4143358 ”nmc
| I ablecinths § raH1E Y Procet Layout..
1 Towcls 101.230.92

- r

122 [Northwest Total 263.55165 e Tl

13 |Southeast frea rugs 46,287 55
4] Placerrals $ 4852788

15| Slipcovers $ 3190187

16 | | ahlecinths

1/ |Snutheast Tnral F124.017 20
18 |Southwiest Arca rugs £ 1.02855

14”4 » ) Product Sales within Region { [«[" 777 7

-

Figure 2-18: Some of the buttons in the dialog box differ if you start by
selecting a Data field.
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TIP: If you are going to base an Excel chart on a pivot table
(that's different from building a pivot chart), you should proba-
bly first remove the pivot table's subtotals.

Of course, you can also use the PivotTable Field dialog to reset subtotals to
Automatic. Automatic in this context means that if the Data field is exclusively
numeric, the subtotal summary defaults to Sum. If there's even one text value in the
Data field, the subtotal summary defaults to Count.

TIP: | don't think you're going to have much use for this, but
just so you know: When you choose the Custom subtotal but-
ton, you can select the subtotal summary that you want to
use: Sum, Count, Average, efc.

Grouping Numeric Fields

Earlier, in this chapter's section called Grouping Row Values, I mentioned that you
can cause a pivot table to group numeric values into categories that are useful for
analysis. (It helps to remember that you group those values affer you've built the
pivot table.) This section shows you how to do that.

Grouping on a Purely Numeric Field

Suppose that you want to take a look at the number of sales a company makes,
according to the sales revenue for each sale. Using the list shown earlier in
Figure 2-14, you could use the pivot table wizard just as described in this sec-
tion, except that you would treat the Sales field in the list as both a row field and
a data field.

TIP: This approach, using the same field as both a row field
and a data field, is a good way to familiarize yourself with a
new set of transactions. For example, | often look at the
count of various items by using something such as Product
as a row field and also as a data field, with the summary set
to Count.
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A pivot table with a row field that has individual numeric items — especially
sales or cost figures — is often uninformative. You can learn more if you take these

steps:
1. Right-click any cell in the row field.
2. From the shortcut menu, choose Group and Show Detail (your ver-
sion of Excel might show Group and Outline instead) and choose
Group from the submenu.
3. You'll see the Grouping dialog box shown in Figure 2-19. The
quickest move now is to accept the default values and click OK. If
you do, you'll see the pivot table shown in Figure 2-20.
Al s | ¢ | b | E | F | & | H | 7
1 =
5| Grouping
3 |Count of Sales Auto
4 |Sales ~ | Taotal ) -
5% 1028 55 1 I¥ Starting at: 1028,55]
B|$ 254417 1 ¥ Ending at:  [58221.64
7 |$ 418540| 1 By: 10000
8 |$ F22335| 1
9% 42915 1 O | Canicel |
i0[§ 1163533] 1
M[$ 1182577 1
|<17< qi >I1§S13T55%Lu_nts;| | | vl

Figure 2-19: If the checkboxes are filled, Excel figures the minimum
and maximum values for you.

A Bl ¢ | o | E | F | & | H | 1 | =
Count of Sales
Sales « |Total
1028.55-11028.55
11028 55-21028 55
21028.55-31028 .55
31028 55-41028 .55
41028 .55-51028 .55
51028 .565-61028.55
Grand Total 30

= e =]

4 4 » wySales Counts | 4| | vl[

Figure 2-20: This sort of analysis gives you a way to determine where
most of the sales are coming from.
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You can clean up the pivot table some if you specify your own values in the
Grouping dialog box. My tendency with this data would be to set the Minimum to
zero and the Maximum to 60,000. This gets rid of the decimal points in the row
field, and makes the categories a little easier to conceptualize (see Figure 2-21).

A B e = G | H | L il

1 |Count of Sales =
2 |Bales w |Tatal
3 | 0-10000 [
4 | 10000-20000 ]

_5 | 20000-30000 3 —
_ B | 30000-40000 5
7 | 40000-50000 10
8 | S0000-60000 2
3 | Grand Total 30

10 =

M 4 » wySales Counts |4 | | gl

Figure 2-21: Cleaning up the automatic groupings improves readability.

Grouping on a Date or Time Field

Things are somewhat different if you group a row field that shows dates or
times. Figure 2-22 shows a pivot table with Sales Date as the row field, before

grouping.
A | B | C | B] F G H —
1 Sum of Sales Bl
2 |Sales Date Region  Product  Sales Sales Date «|Total
_3 | 11152007 Mortheast Arearugs | $47,924.49 1/15/2007)_$47.924 49
_4 | 211142007 MNortheast  Slipcovers | $14,788.80 2/11/2007) $14,759.50
5 | 22007 Saouthwest Towels $45,841.13 2/21/2007| $45,841.13
B | 2/27/2007|Southeast Arearugs | $11,635.33 20272007 $11,635.33 e
7| 2/28/2007 |Northwest Tahlecloths $12,167.81 22812007 $12,167.81
8 | 3172007 Southwest Placemats | $32,322.12 3172007 $32,322.12
9 | 3/24/2007 Southwest Towels $£486,704 57 32472007 $46,704.67
10| 37292007 MNartheast Towels $53,738.05 3/28/2007| $83,738.08
11| 4/13/2007 | Southeast Tahlecloths $ 4,165.40 4/13/2007|  $4,16540
12| 4/28/2007 Morthwest Slipcovers | $41,433.59 4/28/2007| $41.433.80
13| 4/29/2007 Mortheast Arearugs | $11,825.77 4/29/2007| $11.828.77
14 | 5f30/2007 Mortheast |Slipcovers | $36.402.82 83012007 $36.402.82 =
M 4 » M) Sales by Date / | 4] | Wl

Figure 2-22: Because the Sales Date field is measured by day in the
underlying list, the pivot table automatically gives the field a

different item for each distinct day.
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As before, begin by right-clicking a cell in the row field, and then choose
Group and Show Detail = Group. Excel recognizes the row field as a date field and
shows you a different Grouping dialog box (see Figure 2-23).

A | B ' F 2] H —
| i | Sieanine Sum of Sales =
_2 |Sales Date Region | auto Sales Date «|Total
3 | 1/15/2007 Martheast] © starting at: 5/Z007 1/156/2007| $47,824 45
_d4 | 2112007 Mortheast] & gnding R 2(11/2007] $14,799.50
B | 22142007 Southwes 2/21/2007] $45,841.13
B | 27272007 Southeas 2f27/2007] $11,635.33 B
T | 21282007 Morthwes 2f2B/2007| $12,167.81
_8 | 31172007 Southwes 3M7/2007) $32,322.12
9| 3/24/2007 Saouthwes 32472007 $46,704 67
10| 3/29/2007 MNartheast 3f29/2007| $53,738.08
11| 44132007 Sautheas = 4/13/2007) $4,16540
12| 4/28/2007 Morthwes 4/28/2007| $41.433.89
13| 4/29/2007 Martheast] OF | Canicel | 428/2007]) $11.82577

14 | 5/30/2007 MNortheastieems . P 8/30/2007| $36,402.82 =
4 4 » ¥y Sales by Date { | 4| | o[

Figure 2-23: Excel enables the Number of Days spinner if you choose
Days from the listbox.

You can select more than one grouping level: for example, choose Month and
Year to get month within year. Choose one or more grouping levels and click OK.
Figure 2-24 shows the result of grouping by months.

A | B | C | B] | E F G H —
1 Sum of Sales I~
2 |Sales Date Region  Product  Sales Sales Date «|Total
~3 | 11152007 Mortheast Arearugs  $47 92449 Jan $47,924 49
_4 | 211142007 MNortheast  Slipcovers | $14,789.80 Feh $84 44417
& | 22007 Saouthwest Towels $45,841.13 Mar $132,764 .84
_B | 2/27/2007 | Southeast Arearugs | $11,635.33 Apar $87424 .76 T
_7 | 2/28/2007 |MNorthwest Tahlecloths | $12 167 .81 My $36,402 .82
8 | 31172007 Southwest Placemats | $32,322.12 Jdun $93,0688.32
9| 3/24/2007 Southwest Towels $46,704 57 Jul $7845331
10| 37292007 Mortheast  Towels $83,738.08 Aug $138,274.20
11| 44132007 | Southeast Tahlecloths $ 4,165.40 Sep $74.800.23
12| 4/28/2007 Morthwest Slipcovers | $41,433.59 Oct $85,857.96
13| 4/29/2007 Mortheast Arearugs | $11,825.77 Mo $59,250.19
14| 5/30/2007 Mortheast |Slipcovers | $ 36 402 82 Grand Total | $886.665.29 =
4 » »ySales by Date { | 4| | ai

Figure 2-24: You can group a row field or a column field, but not a page
field.
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Too Much Information: The Data Cache

Every pivot table has a supporting component called the data cache, or just the cache.
The data that the pivot table summarizes is stored in the cache. In a sense, the cache is
redundant, because it contains all the information that you have in the pivot table's data
source (so far in this chapter, the only data source we've discussed is a worksheet list,
but there are other sources we have yet to get to). The cache is useful largely because
it stores the data in a format that the pivot table can use quickly and efficiently.

That's about as much as you really need to know about the cache: basically, that
it's there. Unless you're thirsty for more information, skip ahead to the next section.
But if you want to know a bit more, read on: you'll see some reasons that pivot
tables behave as they do.

What's in the Cache?

If you've used pivot tables before, you've probably noticed that when you change the
underlying data (for example by adding or deleting records, or adding a new field)
the pivot table doesn't automatically update. This is different from Excel's normal
behavior. Usually, when you change data in a worksheet, formulas and charts that
are based on the data update immediately and automatically.

Things are different with pivot tables. When you add data to your underlying
data source, you have to tell Excel to update (or refresh, or recalculate — use what-
ever term you're most comfortable with) the pivot table.

TIP: You refresh a pivot table by selecting one of its cells and
choosing Refresh Data from the Data menu (you can also use
the pivot table toolbar, or right-click a cell in the pivot table
and use the shortcut menu).

When you refresh a pivot table's data, what you're actually doing is refreshing the
cache: you're adding new records to it, or deleting them, or adding a field. Once the cache
is refreshed, the pivot table automatically updates to reflect the change you've made.

The presence of the cache dates back to the 1990s, when pivot tables were first
introduced in Excel. At the time, disk storage space was relatively hard to come by
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on personal computers. Internal disks tended to offer only a few megabytes of capac-
ity. So Excel tried to offer some ways for you to save space.

One of those ways was (and still is) to save a workbook containing a pivot table
without the cache. This made for a smaller workbook file, but it also meant that any
time you updated the underlying data source, Excel had to rebuild the cache. It's the
old tradeoff: time for space, just like in chess.

Internal disks are now much, much larger than they were in the 1990s and
there's much less reason to worry about a bigger file due to the presence of a pivot
table cache. There are excellent reasons to keep the cache in the file, though, and
we'll look at some of them next.

How the Cache Helps

Beyond being just a place to store a pivot table's underlying data, the cache can help
you in other ways, as described in the following sections.

Discarding the Underlying Data

Suppose that you build a pivot table from an Excel list, as we've done in this chap-
ter's examples. The underlying data in the list might be confidential on a record-by-
record basis, but not in the aggregate. For example, you might want to build a pivot
table that summarizes regional sales figures, and the table is based on a list of indi-
vidual records for specific sales reps. You'd prefer not to have that list hanging
around so that people can view it.

Once you've built the pivot table from the list, all the list's data is stored in the cache,
and you can afford to get rid of the list. You can clear the range that it occupies, or — if
it's on a different worksheet than the pivot table — you can just delete the worksheet.

Because all the data's in the cache, you can rearrange the pivot table (for exam-
ple, changing a row field to a page field), change the subtotals, change the data sum-
mary from, say, Sum to Count, and so on. The underlying list is not needed for that
kind of operation.

Does it feel like you're taking a chance by throwing out the underlying data?
Are you concerned that your data is floating away with the bathwater? Don't stress:
you can bring the list back by double-clicking the pivot table's Grand Total cell.
Excel responds by inserting a new worksheet and writing all the original, underlying
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data in the form of an Excel list. Excel can do that because the cache has all the nec-
essary information: field names, field values and records.

For this to work, you have to have a particular option set; it’s the default option,
so it will be set properly unless someone has deselected it. If you right-click a cell in
a pivot table, one of the menu items you see is Table Options (see Figure 2-25).
Select that item and be sure that the Enable Drill to Details checkbox is filled.

If you don't see the Grand Total cell, you can get the table to show it by taking
these steps:
1. Right-click any cell in the pivot table.

2. From the shortcut menu, choose Table Options. The dialog box
shown in Figure 2-25 appears.

3. Fill both the Grand Totals for Columns and the Grand Totals for
Rows checkboxes.

4. Click OK.
A B c | D = =0 5 =
1 |Sum of Sales " i ) — | I
2 |Sales Date w|Total Riyot]able Option EI
3 |dan $47,924 45
S Feb $84,444.17 Format options
%Es: $;g$'z gj?g I¥ Grand totals For columns Page layout:  |Down, Then Over
Z Mz 3640282 E irin: Lotaltstfoglrows Fields per column: |
8 |Jun 9306839} | © ;“b: :“l“:dda 7 .
9 |dul 7845331 r Mu o TIJ_II SR I For error values, show:
10 |Aug $136,274.20 R
1 SEp $?4,BDD.23 |¥ Preserve formatting I¥ Far empty cells, show:
1__2 Oict a5 B57 9B v lI;:gpeeat item labels on each printed |~ Set print titles
13 [Nov $59,250.19 o
14 |Grand Total | $886,665.28| | poa options
i [rata source options: External data options:
16 | Iv Save data with kable lavout ™
S W Enable drill to details =
18 [ Refresh on open ™
13 r
ol =
21 ok | cancel |
22 -

Figure 2-25: To get rid of the cache, clear the Save Data with Table
Layout checkbox.
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Now you will find a cell in the bottom row and rightmost column of the pivot
table that's labeled Grand Total. Double-click that cell to get a new worksheet with
the data in it as a list.

Basing One Pivot Table on Another

Again referring back to Figure 2-14, notice that one of your options for an underly-
ing data source is Another PivotTable or PivotChart Report. All this means is that if
you already have one pivot table in the active workbook, you can use its cache as
the basis for another pivot table.

Why would you want to do that? Well, not everyone has your level of expert-
ise in using pivot tables. Although you could bring up the Field List and use it to
change the structure of an existing pivot table, you want to accommodate the
benighted client who doesn't yet know how.

So you might arrange to show the same data, analyzed in two or more different
ways, in two or more different tables. You can make your task easier, and at the
same time guard against mistakes, by building the next table — and subsequent
tables — based on the first one. That means that all the pivot tables you build in
this fashion will be based on the same data set. You won't have to worry about get-
ting 150 records into one pivot table, and 149 into another due to a misclick.

Another advantage is that if you build one pivot table based (say) on a work-
sheet list, and build all the other pivot tables on that first one, then when you want
to refresh the data you only have to do it once. That one refresh is enough to update
the cache that's shared by all the pivot tables, and so they will all update as a result.

Retrieving the Data as a List

It's not immediately obvious, and you might want to keep this in your hip pocket: If
you look back at Figure 2-14, you see that one of your choices as a data source is
External Data Source. In practice, an External Data Source is usually either a true
database (a file built using Access, Oracle, or any other true database management
system) or a text file (such as the soft copy of a report intended for the printer).

If you've built a pivot table using a true database as the data source, you proba-
bly don't have the data in an Excel workbook in the form of a list. You can get it
there, if you want, by double-clicking the Grand Total cell, just as described earlier,
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even though the underlying data isn't a list. It's the cache that enables you to do
this.

How the Cache Hurts

Well, the cache doesn't really hurt. But there are some things you have to be careful of.
Mainly, these occur when you have two or more pivot tables that share the same cache.

Recall that one of your options when you start building the pivot table is to
indicate that the data you want to use is in another pivot table (or pivot chart). You
can select that option in Step 1 of the pivot table wizard. When you do, Excel dis-
plays a dialog box that shows what pivot tables already exist in the active workbook.
Select one of them, and your new pivot table will share a cache with the existing
pivot table.

TIP: This is just one good reason to supply a descriptive
name for each pivot table using the Table Options dialog box
shown in Figure 2-25.

The problem arises because some structural changes that you make to one pivot
table can turn up in another, as discussed next.

Grouping Problems

Suppose you want one pivot table to show costs by quarter, and you design it so that
it does so. You want another pivot table to show costs by month, to make a point
about seasonality in a company's cost patterns. You decide to base the second pivot
table on the first.

But if you do, you won't be able to group the two pivot tables differently, one
by quarter and one by month. As soon as you group one by month, the other auto-
matically groups itself by month. And when you group the other pivot table by quar-
ter, the first one follows suit.

The solution in this sort of situation is to base both pivot tables on the same
data source, but to avoid basing one pivot table on the other. When you do so for the
second of the two (or more) pivot tables, Excel alerts you that your new pivot table
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will consume less memory if you base it on the existing pivot table. You can choose
Yes to base it on the existing table, and No to keep the tables separate.

If you want to base two or more pivot tables on the same data, but group them
differently, you should choose No, so as to keep them separate. Now you will be
able to choose different grouping levels for the different tables.

Page Field Problems

You can safely ignore this section if you're using Excel 2000 or a later version.
Many companies, however, even in 2007, continue to use Excel 97. (And many of
them have very good reasons for living in the past. The conversion of hundreds — to
say nothing of thousands — of workstations from Office 97 to a later version is a
complex and expensive project.)

If you are using Office 97, be aware that there is a problem with page fields. If
you have several pivot tables on different worksheets and refresh them periodically,
it can happen that two or more pivot tables wind up with the same selection in their
page fields. Therefore, you might have to deal with a pivot table on a worksheet
named January that selects January records, and another pivot table on a worksheet
named February that also selects January records.

This can be embarrassing, and the solution is the same as suggested in the prior
section: base all the pivot tables on the same data source, but don't base them one
another. The final major section in this chapter, Using Named Ranges as Data
Sources, has a recommendation that makes it much easier to base several pivot
tables on the same data source.

Refreshing the Cache Automatically

Later in this chapter, in the section named Building and Refreshing a Pivot Table
From a Dynamic Range, this book describes how you can arrange for a pivot table's
underlying data range to redefine itself automatically. As new data on, say, costs
comes into the workbook, you don't need to tell pivot tables to look further into the
worksheet to find the most complete set of information.

But redefining the reference to the data source is only half the job. The other
half is getting the pivot table to refresh itself based on that new data. There are
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several ways to do this. One is by hand: all you need to do is right-click any cell
in the pivot table and choose Refresh Data from the shortcut menu.

But you have to remember to do that; it's all too easy to assume that the pivot
table contains the most current information and forget that you haven't refreshed it.
So consider doing something to refresh the table automatically.

Refreshing the Pivot Table When You Open the
Workbook

One way to arrange for an automatic refresh is to select an option that forces a refresh.
If you right-click a cell in a pivot table, a shortcut menu appears, and one of its items
is Table Options. Select that item to see the dialog box shown earlier in Figure 2-25.

Clearly, there are many options you can set using this dialog box. The one that's
pertinent to this section is Refresh on Open. Fill this checkbox to get Excel to
refresh the pivot table when you open the workbook.

WARNING: Don't forget to save the workbook after you've
selected this option. If you don't, the option will keep the value
it already had — and if the checkbox was cleared (that's the
default) then the pivot table won't automatically refresh when
you open the workbook.

With this option set, Excel refreshes the pivot table while it is opening the
workbook, before it turns control over to the user. For most situations, that could
very well be all you need. If you open the workbook that contains the pivot table
only occasionally you'll want the pivot table to have refreshed itself — new data
could easily have been put in the workbook since you last opened it.

And if all you do is take a quick look at what the pivot table displays when you
open the workbook, you're in good shape. Only in exceptional cases could you have
the workbook open while a different user is updating the data source.

The Problem Cases

There are two general situations that could cause a pivot table's underlying data to
change without your knowledge, and I’ll go over those in this section.
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The Shared Workbook

One such case occurs when the workbook is shared. (A workbook is shared when
more than one user at a time can have it open and save changes to it. This is done
using Tools = Share Workbook.) You cannot edit — or even build — a pivot table
in a shared workbook, not even if you're the only one who has the workbook open.

NOTE: This is just one of several reasons that | urge my
clients not to use shared workbooks. One of the other reasons
is that they have a tendency to hang — to quit responding to
user input — when they get fairly large. You do not want a
workbook with a lot of data in it to hang.

In a shared workbook, another user could easily edit a pivot table's data source,
and you would not necessarily know that had happened.

External Data Sources

The other case occurs when a pivot table is based on an external data source. The
most typical external data sources are text files, other Excel workbooks, and true
databases. ("Most typical" is a relative term, though, because the majority of pivot
tables are based on worksheet lists.) You build a pivot table that's based on an exter-
nal data source starting with the pivot table wizard's first step (covered earlier in this
chapter).

You would not necessarily know that another user had updated the pivot table's
data source when that source is located in a database or in a different Excel work-
book. That's why you might find useful another checkbox in the Table Options dia-
log box.

Refer back to Figure 2-25, and notice the checkbox labeled Refresh Every X
Minutes. The checkbox, and the associated spinner, are enabled only if the pivot
table is based on an external data source. You can use this checkbox and the spinner
to cause Excel to refresh the pivot table as frequently as you wish from the external
data source. But use a little caution, at least: if the pivot table is based on a large
amount of data, it's possible to clog up a network with frequent, possibly unneces-
sary refreshes.
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TIP: Perhaps the slickest way to design a pivot table is to
keep the underlying data set in a true database, such as SQL
Server, Oracle or Access. Then base the pivot table on that
database, using the External Data Source option in step 1 of
the pivot table wizard. If you do this, you leverage the data
management and retrieval strengths of the database and the
analysis and graphic display strengths of Excel.

Using Named Ranges as Data Sources

Excel has a way of referring to a collection of cells on a given worksheet. Such a
collection is called a range, and it's every bit as important as a list. A range can con-
sist of a single cell, such as cell D5 — in fact, a cell is a range in a formal sense. A
range can also consist of thousands of cells, such as the range A1:Z500.

Ranges are in some ways less formal than lists, and in some ways more so. For
example, you can put any sort of data in a range and orient it as you like. A list — to
be a list — requires that you have field names in the first row, that each subsequent
row represent a different record, and that each column contain a different field.

But ranges are much more forgiving. You'd have to be irrational to do it, but
you could put a record in one row of a range, and another record in one of the
range's columns. A range, in other words, has all the flexibility of the worksheet it's
on as to what goes where: that's all up to you.

On the other hand, a defined range has a couple of things that a list doesn't. One
is a name: all defined ranges have names, like PhoneList or Q4 Actuals. The other is
an address: Excel requires that an address, like D5 or A1:Z500, be associated with
the name of the defined range. (In contrast, recall from Chapter 1 that lists don't
have names, and although they occupy cells they don't have specific cell addresses.)
All defined ranges must have names, and those names must be associated with cell
addresses.

Creating a Named Range for an Aging Report

One useful example, seen in Figure 2-26, is a named range for an aging report.
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A1 - B Acct

A B | c | D == F | G [ H | |
1 | Acet | Amount Sales Date Past Due Closing Date: 121312007 il
2 | 34401 $6,260.33 11427707 34
3 | 18747 $6613.43 11/26/07 35
4 |BB243| $3,149.04 11/22/07 39
5 |34897) $3.959.03 11/17/07 44
6 |598578| $09,035.72 1144407 a7
7 |48287 $1,752.94 10/29/07 63
B |58476| $3955.75 10/18/07 74
9 |60097| $3,039.39 10/12/07 B0
10| 16987/ $ 758.83 1047707 B85
11 | 48064 $1,833.85 10/6/07 86
12 |B2675| $9,959 65 10/2/07 80 T
13 |5B910| $2,747 .88 9/28/07 94
14| 77493 $3.155.85 9/27/07 85
15| 18508| $7.941.37 8/27/07 85
16 |44094| $1,120.03 8/24/07 98
17 | 23425| $5.407 36 8A16/07 108
18 |26287| $8,137.89 8/13/07 109
19 |37005| $2,155.39 9/2/07 120
20 |45207| $4.924 56 9/1/07 121
21 28082) $1,195.40 B/29/07 124
22 |53605| $2,755.04 B/25/07 128
23 |B0510] $7,357.35 Br25/07 128 -
|4 > ¥l Aging Report /| | | 3l

Figure 2-26: Of course, you can create a named range from any set of
cells, not just an aging report.

Here's how to create a range named AgingReport:

1. Select the cells in the range you want to name. In Figure 2-26, that's
A1:D23. (We'll ignore the closing date information in F1:G1, but of
course you could include it.)

2. Choose Insert = Name = Define to see the dialog box shown in
Figure 2-27.

3. In the Names in Workbook box, type a descriptive name, such as
AgingReport.

4. Click OK.

You now have a range named AgingReport in the active workbook. You can use
it as input to a pivot table (instead of typing the cell references in the second step of
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the pivot table wizard — refer back to Figure 2-15 — you can just type the name of

the range).
Al B | e | o | E | F | & | H | =|
_1 | Acet  Amount Sales Date PastDue Closing Date: 12/31/2007 Il
2 |34401 $6.26033 112707 (AR T —
T3 18747 $661343  11/2607 [ ldikiba
4 |86243 $3,149.04 11722007 Mames in workbook:
5 |34897 $395303 111707 | [Agngreport] o |
£ |99578 $9,035.72 11/4/07
7 |48287 $1,75284  10/28/07 - _ dose |
B |59476 $395575 1071807 o
9 |60097 $3039.39 1011207 ==
10|16987 § 75883 1047407 Eekets
1142084 $1,83335 10/B/07
1282675 $9,959.65 10/2/07 | =
13|5B310 $2,747.88 928007 | mefers to:
1477483 $3,155.85 G277 | [—aging Report a3 1140623 =
1518508 $7,841.37 8/27/07
1644084 $1,120.03 8/24/07 58
1723425 $5407.36 8/16/07 106
1826287 $8,137.89 8/13/07 109
1937005 $2,155.39 8/2/07 120
2045207 $4,824 56 8/1/07 121
2129082 $1,19540 B/29/07 124
2253805 $2,755.99 B/25/07 128
2390510 $7,357.35 B/25/07 128 _

R . Aging Report | 4|

| Al

Figure 2-27: There are other ways to add a named range, but this gives

you the most control.

There are many other ways to use a named range, and most of them have to do
with using the name instead of typing a cell reference such as A1:D23. It's easy to
forget or to miskey a cell reference; if you chose a good name for the range, such as
ChartOfAccounts, it's harder to forget or miskey.

Before you start looking into using a named range as input to a pivot table, fol-
lowing are a few basics about named ranges to bear in mind:

Embedding Blanks

The name of the range can't contain embedded blanks. It would be nice to name a
range Aging Report, but Excel won't let you. If you find it jarring to see the two
words run together in AgingReport, consider using an underscore instead of a blank

space: Aging Report.
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Getting Out of the Dialog Box

Notice the other buttons on the Define Name dialog box in Figure 2-27. Click the
Close button if you want to abandon the operation (it just means Cancel). Click the
Add button to add the current name — the dialog box will stay open so that you can
add another named range.

Using the Name Box

A quicker way to name a range is to use the Name Box. In Figure 2-26, you can see
the Name Box above Column A — it shows the address of the active cell, Al, and it
has a dropdown arrow immediately to its right.

To name a range using the Name Box, select a range of cells that you want to
name, click in the Name Box, type the name, and press Enter. That creates the
named range. You can also use the Name Box to go to that range: click in the Name
Box, type the name of the range (or click the dropdown arrow and select it from a
list) and press Enter.

TIP: You can quickly go to a cell by using the Name Box.
Suppose you're in cell A1 and you want to go to cell Z90.
Click in the Name Box, type Z90, and press Enter.

Another helpful feature of the Name Box is that if you have selected a named
range, the name of the range appears in the Name Box. In Figure 2-26, if you had
already named the range AgingReport, and subsequently selected that range, its
name would appear in the Name Box.

NOTE: This feature of the Name Box does not, unfortunately,
apply to dynamic range names, which are discussed next.

Static and Dynamic Named Ranges

The prior section described one type of named range — a static range, the type that
is best known. ("Best known" is another relative expression, of course. An educated
guess is that perhaps 10% of those who use Excel frequently have even heard of a
named range.)
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A static named range is static because it doesn't change without your help. It
doesn't move, and its dimensions don't change. Left to its own devices, a static range
that consists of 24 rows and 10 columns will always have 24 rows and 10 columns.

But what if you have use for a range that can grow or shrink as a function of
the number of values it contains? For example, to return to the account aging report
in Figure 2-26, what happens when another account becomes past due? You add it to
the range of data that's currently in A1:D23, of course, but now the data would occu-
py A1:D24, and the range name still refers to A1:D23. If you used the range name
AgingReport in an analysis, you'd miss the 23rd record (in the 24th row).

The Refers To Box

Have another look at Figure 2-27, in particular the Define Name dialog box. Notice
at the bottom of its window is a box labeled Refers To. That box contains this infor-
mation:

='Aging Report'!$A$1:$D$23
There are some points of interest about that entry:

* It begins with an equal sign. Thus, it has aspects similar to a formula
in a worksheet cell. In particular, it can be calculated and recalculat-
ed.

* It begins with the name of the worksheet where the range is located.
Because the name of the worksheet in this case has a blank in it
(between "Aging" and "Report"), Excel puts single quotes around it.

* Excel separates the name of the worksheet from the cell address
with an exclamation point. This convention occurs elsewhere in
Excel, such as in charts.

* The range address, $A$1:$D$23, is an absolute reference. The col-
umn designations, A and D, and the row designations, 1 and 23, are
each preceded by dollar signs. These dollar signs anchor the address,
making it fixed, absolute, static.

You can tinker with this definition of where to find the range named
AgingReport. In particular, you can make the definition sensitive to the number of
accounts that should be included in the named range — so that when a new account
is added, the range's definition expands to include the new account. Then the named
range is no longer static, it's dynamic.
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And we're now getting close to the reason I've stuck all this stuff about named
ranges in the middle of a chapter on pivot tables. If you base a pivot table on a
dynamic named range, you don't need to change the range address of the pivot
table's input data. it changes automatically as new data becomes available. If you
use pivot tables extensively to synthesize, analyze and chart, for example, your
clients' operating costs and revenue sources, the ability to get them to update their
addresses automatically is huge.

Basing a pivot table on data in a dynamic named range doesn’t by itself com-
pletely solve the problem of updating a pivot table with new data. You still have to
refresh the pivot table. But that too can be automated, as you saw earlier in this
chapter's section titled Refreshing the Cache Automatically.

When you can automatically change the address of the input data and automati-
cally refresh the pivot table, you're in a position to hand your client a valuable
resource. Or, if you prefer to keep it to yourself, you've arranged to save yourself a
lot of time and grief going forward.

A couple of additional tools are needed to make a named range dynamic: the
OFFSET function and the COUNTA function.

The OFFSET Function

OFFSET is a worksheet function that directs Excel's attention from one cell to
another, but it's also useful in the definition of a dynamic named range. Here's the
OFFSET syntax as you might use it on a worksheet:

=OFFSET(celladdress,rows,columns)
For example:
=OFFSET(A1,1,2)
This example tells Excel to return a value in a cell that

* is offset from cell A1 — that is, a cell that is removed from Al by
some number of rows and some number of columns. (In this exam-
ple, Al is the function's first argument.)
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* is found one row below A1 (1 is the second argument in the func-
tion)
* is found two columns to the right of cell Al.

Here's another example:
=OFFSET(C2,5,4)

The second example tells Excel to return a value in a cell that

* is offset from cell C2.
« is found five rows below C2.
* is found four columns to the right of cell C2.

Finally, a special case — it will look trivial at first, but it turns out to have plen-
ty of uses, including dynamic named ranges:

=OFFSET(A5,0,0)

This usage calls for an offset of zero rows and zero columns from cell AS —
that is, it refers to cell A5 itself.

The OFFSET Function in a Named Range

Suppose you want to name a worksheet range that starts in cell A1 and ends in cell
D4. As we've seen, the usual definition of that range — shown in the Refers To box
of the Define Name dialog — would be:

=$A$1:$D$4
But you could also type this into the Refers To box:
=0OFFSET($A%1,0,0,4,5)

Here, the OFFSET function refers to cell $A$1, and just as in the last example
it offsets zero rows and zero columns, so it includes A1 itself. But there are two
more arguments that we haven't looked at yet: the numerals 4 and 5.

They tell Excel that the reference that OFFSET should return is to have four
rows and five columns. Formally, these are optional arguments, but they're necessary
if you're to get a range that consists of multiple cells when the basis (here, $AS$1) is
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one cell only. In their absence, Excel assumes one row and one column. That is, the
following two examples are equivalent:

=OFFSET($A$1,0,0)
=OFFSET($A$1,0,0,1,1)

So, suppose you entered this in the Refers To box of the Define Name dialog:

=OFFSET($A$1,0,0,4,5)
Then the range you're defining would occupy A1:E4. That's the range that

* is offset zero rows from Al.

* is offset zero columns from Al.
* occupies four rows.

* occupies five columns.

The problem is that the range is still static. It always occupies four rows and
five columns and starts in cell Al. You're about to make it dynamic, though.

Making the Range Name Dynamic

It's wise to back up a moment to review the purpose of all this stuff. The problem is
to get a pivot table to react automatically after new information enters the worksheet
range that contains its underlying data. The pivot table might be getting the total of
revenues for each month — then, when a sales region reports its total revenue for the
current month, that information goes into a worksheet list and we want the pivot
table to add that revenue to its analysis.

What you can do is count the number of records in the list. Suppose that the list
occupies cells A1:B25. A new record arrives, stating that $100,000 in revenue was
recognized in November. The value November goes into cell A26 and $700,000 goes
into B26. The list has expanded by one row.

Suppose that you want the worksheet to keep track of the number of records in
the list. In cell C1, say, you could enter this formula:

=COUNTA(AA) - 1

That formula counts the number of values in Column A, and subtracts 1 from
that. The reason for subtracting 1 is that one value in Column A is the list's column
header — something such as the word "Month".
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TIP: There are a couple of counting functions in Excel. One is
COUNT; which counts the number of numeric values in a
range of cells. The other is COUNTA, which counts the num-
ber of values in a range of cells, regardless of whether the
values are numeric or text. COUNTA is used here because
it's more general, but COUNT often works just as well. You
know the nature of your data better than | do.

Now you're ready to define a dynamic range name. The definition uses the
COUNTA function as an argument to the OFFSET function — the result of COUNTA
tells OFFSET how many rows to include in the named range. For a dynamic range
name that starts in cell A1 and has four columns, the Refers To box would have:

=OFFSET($A$1,0,0,COUNTA($A:$A),4)

This definition probably looks more intimidating than it really is. Try interpreting
it piecemeal, from the inside out, and begin by assuming that you have values in the
range A1:A5 and nowhere else in Column A. (For the purpose of this example, it does-
n't matter whether there are values in columns B through D, but as a practical matter
you'd usually have values in those columns, associated with values in Column A.)

In that case, this part of the definition:

COUNTA(SA:$A)

calculates the number of values found in Column A — under the assumption in the
last paragraph, that's 5. Substituting into the full definition you get:

=OFFSET($A$1,0,0,5,4)

That is, the range that is offset from A1 by zero rows and zero columns, and
that contains five rows and four columns: using standard Excel notation, A1:D5.

Now suppose that you add new data to that range, in cell A6 (and perhaps
B6:D6). If you do, the COUNTA function returns 6, not 5: it's sensitive to the num-
ber of values it finds. The definition adjusts to:

=OFFSET($A%$1,0,0,6,4)

and the range name's definition contains six rows instead of five: A1:D6. You've
defined a dynamic range name.
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Try it yourself by taking these steps:

. Enter, say, four values in A1:A4.

. Choose Insert > Name = Define.

3. In the Names in Workbook box, type a name such as

5.
6.
7.

DynamicRange.

. In the Refers To box, type

=OFFSET($A$1,0,0,COUNTA(SA:$A),4)
Click OK.
Click in the Name Box and type the name you chose in Step 3.

Press Enter.

Excel will select the cells defined by columns A through D, and by as many
rows as you have values in Column A.

WARNING: Keep any extraneous values (or formulas) out of
the column whose values you're counting. Suppose you have

" n

a simple "q" in cell A957. That's a value in Column A, and if
you're defining your dynamic range using a count of the num-
ber of values in the column, you would wind up with one more
row in the dynamic range than you really want.

Now, enter another value in a blank cell in Column A, and repeat steps 6 and 7,
above. Excel will select one row more than it did before.

Before you leave this section, be sure you follow the rationale for all this —
which might well seem like a bunch of handwaving from some deranged geek. By
defining a dynamic range name, you can arrange for the range's dimensions (usually,
its number of rows) to be automatically recalculated when new data is added. In

turn:

* Any charts that depend on that range name will also automatically

redraw.

* Any formulas that depend on values in the named data range will

automatically recalculate.
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* Any pivot tables that depend on values in the named data range will
automatically grab the new data when they are refreshed — which
can also be done automatically.

Building and Refreshing a Pivot Table From a
Dynamic Range

In this chapter's section titled Building Pivot Tables, you saw how you could make ref-
erence to a range of cells occupied by a list, that would serve as the underlying data for
the pivot table. That section mentioned that you could select a cell in the list prior to
starting the pivot table wizard with Data = PivotTable and PivotChart Report.

If you do so, Excel determines the boundaries of the list and proposes the range
it occupies as the pivot table's data source. If you do not begin by selecting a cell in
the list, you must identify the range address of the list by typing it, or by dragging
through the range with your mouse.

If you base the pivot table on a dynamic range name, then (both at the outset
and later on) you don't need to bother with that. Just type the name of the range in
the Range box that you see in Step 2 of the pivot table wizard, and proceed just as
before. Figure 2-28 starts an example of how this is done.

Lok dlo o I e g E F G H =
_1 ! Acet  Amount Sales Date PastDue] Closing Date: 1213112007
2 134401 $6.260.30 1142707 : >
T3 018747 $861343 112607 ekt &
4 186243 $3,14904  11/22/07 | Names nmorkbook:
5 134897 $308803 111407 | [PvetDats [ & |
6199570 $9,005.72 11/4/07 |
7148287 $1,75284 10/29/07 dose |
8 159476 $3,955.75  10/18/07 add
9 60097 $3.039.33 101207
10}16807 § 75000 10/7/07 __Dekete |
11148064 $1,833.85 10/6/07
12182675 $9,959.65 107207 =l =
13156010 $2.747.83 /2807 | gefersto:
14177490 $3.155.05 W27 | [<orrsei(gas,v,o,couniaggassa), ) B
15118508 $7,941.37 g/27/07 .
16144084 $1,120.03 9/24/07 g8
1423125 $5407.36 B/18/07 106
1026207 $0,137.09 8i12/07 108;
19137005 $72,15539 N7 190}
20145207 $4,924.56 91107 121}
21120082 $1,18540 8/20/07 124

$2,755.99 0/25/07 120}

.....................................

WA + 1 Aging Report /[ 4| 1 Hl

Figure 2-28: Note the defined name of the range, and what it refers to.
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It's usual (if not strictly necessary) to begin by selecting a range of cells when
you're defining a static range name. But with a dynamic range name, it's pointless to
do so because you're setting the range up so that it will redefine itself.

In Figure 2-28, the user has not selected a range of cells, but has chosen Insert
- Name = Define. Now take the following steps:

1.
2.

In the Names in Workbook box, type a name such as PivotData.

In the Refers To box, type
=OFFSET($A$1,0,0,COUNTA($A:$A),4)

. Click OK to get the name defined.
. Choose Data = PivotTable and PivotChart Report.

5. In Step 1 of the pivot table wizard, accept the defaults of Excel List

and PivotTable. Click Next.

. In Step 2 of the wizard, type into the Range box the name, perhaps

PivotData, that you used in Step 1 of #his list. Click Next.

. In Step 3 of the wizard, make your own choice about where to

locate the pivot table, and click Finish.

. The schematic appears on the worksheet, and the PivotTable Field

List dialog box shows up too. If you use the data and field names
shown in Figure 2-28, add Sales Date to the Row Area and Amount
to the Data Area, then group on Sales Date. Specific instructions are
in the Building Pivot Tables section, earlier in this chapter.

TIP: When I'm just starting to develop a pivot table, | like to
put it on the worksheet that contains the underlying data. That
makes it easier to see what's going on if | get a stupid result.

If all the data you entered for Amount is truly numeric, the pivot table defaults
to Sum as the data summary, and you'll get the sum of the dollars for each account.

Now, to test your dynamic named range's capabilities, add a record to the list,
as shown in Figure 2-29.



Chapter 2 « Pivot Tables

A B C | o B G | H ] | =1
1| Acet | Amount | Sales Date | Past Due Closing Date: 12/31/2007 =
2 [ 34401 $6,26033 112707 34
3 |18747 $661343 11/26/07 35 Sum of Amount
4 |BB243 $3.149.04 1142207 34 Past Due ¥ |Tatal
5 | 34897 $3.850.03 1117/07 44 3160 $30,504.88
6 | 99578 $9,035.72 11/4/07 a7 5150 $21,300.41
7 48287 $1,752594 10/29/07 63 91-120 $30,665.77
8 59476 $3.955.75 10/18/07 74 121-150 $16,233.30
9 |B0097 $3,039.39 101207 a0 Grand Total §95,804.36
10| 16987 $ 7e8.83 10/7/07 85
11|48064 $1,833.85 10/6/07 86
12 |B2675 $0,859.65 107207 a0
13| 56910 $2,747.88 9/28/07 94 ]
14| 77493 $3,15585 9r27/07 95
15| 18508 $7.941.37 9r27/07 95
16| 44084 $1,120.03 9/24/07 93
1723425 $5407.36 16/07 106
15| 26287 $8,137.89 9/13/07 109
18| 37005 $2,155349 9/2107 120
20 |45207 $4.924 58 8/1/07 121
21/29082 $1,19540 8/28/07 124
22| 53605 $2,765499 8/25/07 128
23 [B0510 $7.357.35 8/25/07 128
24192848/ $1,587.33 11/30/07 a1l
25

ey b Aging Report /|« |

| s

Figure 2-29: Adding the record expands the range name's definition by one row.

Lastly, right-click anywhere in the pivot table and choose Refresh Data from
the shortcut menu. You should see the pivot table summary update to reflect the
presence of the new record.
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Chapter 3
Common Sizing Using Worksheets

The Rationale for Common Sizing
Common Sizing Income Statements

Other Uses of Common Sizing

application for common sizing financial statements. You have several tools

available to help with different purposes for common sized statements: for
example, you might create a common sized statement that can recalculate as new
information comes to hand, or one that is static — that is, one that has values only,
and no formulas.

B ecause of its ability to calculate and recalculate formulas, Excel is an ideal

This chapter begins by discussing the rationale for common sized statements.
That may seem pretty basic, but I've met many accountants who are unfamiliar with
the concepts involved. (If the idea is old hat to you, by all means skip ahead to the
section titled Common Sizing Income Statements.) The chapter then goes on to
describe how you can use Excel to common size income statements and balance
sheets, to make comparisons with earlier accounting periods or with another compa-
ny or even an entire industry.

The Rationale for Common Sizing

We're all so used to looking at income statements and balance sheets that are denom-
inated in dollars that seeing one denominated in percentages seems a little odd. But
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when you look at a common sized financial report that shows percentages, you find
that it makes a lot of sense.

The idea itself is pretty straightforward. Suppose that you're looking at an
income statement. Many of the values shown there — especially on an income state-
ment that's been structured to support management decisions — are driven by net
sales. Salaries, COGS and virtually any other variable cost, even fixed costs — in a
rationally-managed company all of these rise and fall, if only eventually, with net
sales.

So it's sensible to look at how dollars are allocated to various cost categories as
a percentage of net sales, something to which they react. A company might have
$10,000,000 in net sales in 2007 and pay $2,000,000 in salaries. Another company
in the same business sector might have $30,000,000 in net sales for the same year
and pay $10,000,000 in salaries.

One company pays 20% of its net sales in salaries, and the other pays 33%.
With very small firms — say, those with less than $1,000,000 in annual net sales —
that difference wouldn't jump out at you. Just sending a CFO to jail for six years
could easily account for the difference.

But with companies that have tens of millions of dollars in annual net sales, the
difference between 20% and 30% for salaries is probably worth taking a quick look.
You might find something of interest, or problematic — or nothing at all — but at
least your attention was directed to a difference that's a little bit unusual.

It would be more difficult to notice that difference if you were simply looking
at raw dollars, especially if you're looking through income statements for 20 or 30
companies. With net sales or revenues all over the ballpark, it's hard to tell if any-
thing's out of whack.

But when you've common sized the statements, you eliminate the effect of
one principal source of variation: net sales measured in raw dollars. With every-
thing on the income statement cast in terms of percent of net sales, it's much easier
to make comparisons between companies. And that, of course, puts you in a posi-
tion to assess how two or more companies differ in terms of how they structure
their costs.

There are various sources of income statements and balance sheets, available
for particular business sectors and already common sized. One source, for example,
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is Risk Management Associates at http://www.rmahq.org/RMA, which sells com-

mon sized reports. This is one way to compare a particular company in which you
are interested with a larger number of companies in the same general line of busi-
ness.

It's not necessary to limit the comparison to one company and another, or
one company and an entire sector. It can be helpful to look at a comparative
income statement that describes the activities of one company at different points
in time, usually consecutive accounting periods. In that case, of course, you
would express all costs from, say, 2006 in terms of percentage of net sales for
2006, and all costs from 2007 in terms of net sales for 2007. Once you've
removed the effect of variation in net sales, you can easily see the change in cost
allocation from year to year.

Common Sizing Income Statements

You have a choice, early in the process of common sizing an income statement, as to
whether you want the common sized statement to be fixed or changeable. If it's
fixed, that means you'll see the same percentages whether or not you get new num-
bers for the original income statement: such a common sized statement stores fixed
percentages.

On the other hand, if the common sized statement is changeable, you can see
the percentages change as new data arrives. It's changeable because you've stored the
percentages as formulas, and if you get more information about costs or sales, the
common sized statement recalculates its formulas and show you updated percent-
ages.

Probably, the best time to "freeze" a common sized statement is at the end of
the accounting period it covers, after adjusting entries have been made and the only
further change would be restatements. Bear in mind, though, that you can always
convert the statement back to formula-based common sizing by going back to the
original statement.

The Mechanics: Using Formulas

Figure 3-1 shows an ordinary income statement. (It's highly simplified and con-
densed for reasons of space.) This section describes how to create a common sized
income statement that's based on formulas, and retains them.
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Excel for Accountants

A B | C D EIEE =

1 |Net Sales $ 3414926 B
2 |Cost of Goods Sald 1,866,171

3 |Gross Profit 1,548,755
IOperating Expenses
al| Travel & Entertainment 88 305
B | Commissions 274,153
_7 |Total Sales Expenses 363,458

]
| 2 | Salaries 267 543
0] Communications 20,320
1 Insurance 25400
| Advertising 7E,622
3] Depreciation 33443
14 |Total Administrative Expenses 473,328

15
ETutal Operating Expenses 786,788
17 |Operating Income 761,969
18 |Interest Expense 130,805
19 |Income before taxes 631,164

20 Taxes 165,357
21 |Net Income $ 465,806 -
22|
23]
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Figure 3-1: A standard, condensed income statement, denominated in

dollars.

To convert the statement shown in Figure 3-1 to a common sized statement,
using Net Sales, take these steps:

1.

If your workbook has a blank worksheet in it, go on to Step 2.
Otherwise, choose Insert = Worksheet.

. If necessary, activate a blank worksheet and select cell C1. (In this

case Cl1 is the cell that contains the first of the numeric values in the
original income statement.)

Type an equal sign, switch to the worksheet with the income state-
ment, and click in cell C1.

. Type a slash (that is, the divided by sign or the division operator).

. Click in cell C1 (or wherever the income statement has stored the

net sales value).

. Press Enter. Excel returns you to the blank worksheet. If necessary,

select cell C1 again. The formula in the formula bar should look
something like this:
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='Income Statement'!C1/'Income Statement'!C1

depending on the name of the worksheet that contains the original
income statement.

. Hold down the mouse button and drag the mouse pointer across the

reference that's to the right of the division operator in the formula
bar, to highlight it. In this case, that's the second instance of C1 in
the formula.

. Press the F4 key once, and then press Enter. This will convert the

highlighted portion of the formula from a relative reference to an
absolute reference. (You could also just type the dollar signs directly
into the reference, but the F4 key is easier, especially when you're
using a laptop on a bumpy flight.) The formula in the formula bar
will now look like this:

='Income Statement'!C1/'Income Statement'!$C$1

9.

10.

11.

12.

13.

14.

If necessary, activate cell C1 again. Click th